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Overview

Have you ever used the Internet or CompuServe? If so, you've probably encountered ZIP files. Are you
a Windows user? If so, WinZip is THE way to handle these archived files.

WinZip brings the convenience of Windows to the use of Zip files and other compression formats.
Windows 95, NT, and Windows 3.1 versions are shipped on the same disk. WinZip features include:

Windows 95 support: WinZip includes long filename support and tight integration with the Windows 95
shell. Drag and drop to or from the Explorer, or zip and unzip without leaving the Explorer.

Internet support: WinZip features built-in support for popular Internet file formats: TAR, gzip, Unix
compress, UUEncode, XXencode, BinHex, and MIME. ARJ, LZH, and ARC files are supported via
external programs. You can use WinZip to access almost all the files you download from the Internet.
In addition, the freely downloadable WinZip Internet Browser Support Add-On lets you download and
open archives with one click using Microsoft Internet Explorer or Netscape Navigator.

Built-in ZIP and UNZIP: WinZip includes 100% PKZIP-compatible ZIP and UNZIP, including support for
multi-disk Zip files (PKZIP and PKUNZIP are not required for any zipping or unzipping operations).

The WinZip Wizard: This optional feature uses the standard and familiar "wizard" interface to simplify
the process of unzipping and installing software distributed in Zip files. The WinZip Wizard is not
targeted at experienced users, but is ideal for the rapidly growing number of PC users getting started with
Zip files. When these users gain confidence or want to use more advanced zipping features, the full
WinZip Classic interface is just a click away.

Create files that unzip themselves: WinZip Self-Extractor Personal Edition is now included with
WinZip. Self-extracting files are ideal for sending compressed files to others who may not own or know
how to use file compression software.

Virus Scanner Support: WinZip can be configured to work with most virus scanners.

WinZip is extremely easy to use! To open an archive simply double click on an archive listed in the
File Manager or Explorer, drag and drop an archive onto WinZip, or use the standard Open dialog box.
The main WinZip window features a list box with the names, sizes, and date/time stamps of all files in the
open archive. This list can be scrolled and sorted on any field. A tool bar provides fast access to
commonly used actions. All options (including window size and position) can be saved and restored.
Extensive context sensitive help is always available.

Double clicking on a file in the main WinZip window has the same effect as double clicking in the File
Manager or Explorer. First the file is extracted from the archive. Then, if the file is executable, it is run.
Otherwise, the file is opened by the appropriate application (for example, Windows Write or WordPad for
*WRI files) based on standard Windows associations.

The Windows Drag and Drop interface is fully supported. You can drag and drop files from WinZip to
other applications. WinZip will extract the files before dropping them on the target application. The
target application will treat the files as if they had been dropped by the File Manager or Explorer. You
can also drop archives on WinZip to open them, or drop files on WinZip to add them to the open archive.

Under Windows 3.1 WinZip's unique Install/Try/Uninstall Feature makes it easy to install and uninstall
software distributed in archives. This feature can save megabytes of disk space by tracking and
removing all traces of an application. WinZip will run the installation program in an archive, give you a
chance to try the program, and optionally offer to restore your system to its original state. The uninstall
step can selectively remove folders, files, icons, or program groups created by an install program, and
can restore any altered INI files. You have complete control over the uninstall process, and no changes
are made without approval.

If an archive doesn't have an "install" or "setup" program you can use the CheckOut facility to easily try
the files in the archive. The CheckOut facility will extract all files and create a program group with icons
for all or some files. Just double click on an icon in the CheckOut group to view the corresponding file
with the appropriate application. WinZip will optionally delete the CheckOut files and program group.



Magazine Quotes

Recent awards include

1997 "People's Choice" Shareware Industry Award

1997 Home Office Computing "Editor's Pick" Award

1996 PC Week Labs "Analyst Choice" Award (December 9)

1996 PC Magazine "Best Utility" Shareware Award

1996 Windows Magazine "Win100" Award

1996 PC Computing "Best of the Internet" Award for compression

In previous years WinZip was a finalist for the PC Computing 1995 "MVP" Award, and was voted "Best
Utility" at the 1994 annual Shareware Industry Awards, and won the Windows Magazine "Win100" Award

in 1993.

Here's what magazine reviews say about WinZip:

"Easy to learn yet robust enough to satisfy power users", PC Magazine, 4/8/97
"For working with .ZIP archives, there's no better tool than WinZip", Windows Sources, 3/1/97
"The most essential utility to decompress all those pesky ZIP files", PC World Online, 3/1/97

"It's rare to find one product in a hard-fought market category that bests its competition in nearly
every respect. WinZip 6.2 is one of these products. It towers over the rest of the market." PC
Week 12/9/96

"Of the many file-compression and extraction utilities out there, this one is the best - and the
easiest to use" Windows Magazine, 11/96

"Put the squeeze on porky downloads and file transfers with this Windows compression utility" PC
Computing, 10/96

"If you check out a lot of shareware, WinZip is a must." Home Office Computing, 9/96
"WinZip 6.1 is the easiest compression program to use" Computer Shopper, 8/96

"The best data-compression and archiving utility around" PC Computing 7/96

"Makes handling compressed files incredibly easy" Windows Magazine 7/96

"With version 6.1, WinZip continues to be a must have utility for all users" PC Magazine 7/96

"In the utility category, the WinZip for Windows 95/NT compression software is rated the best."
Computer Life 7/96

"Provides all the features of a standard file archiving utility. Then it goes above and beyond the
call of duty in unexpected ways." Government Computer News, 8/96

"By far the best Windows 95 file-compression utility going" Computer Shopper, 6/96

"Zip front ends ... are all the rage. The undisputed leader of the pack is WinZip - no competition"
PC World 6/96

"No Windows 95 desktop should be without a file archiving utility, and Nico Mak Computing's
WinZip 6.0 is the one to have." PC Magazine 5/96

"Nico Mak continues to add zip to its classic compression utility" Windows Sources 5/96
"lts a breeze to use" Windows Magazine 5/96
"Drag and drop everywhere in Windows 95" Byte 4/96

"The best all-purpose file-compression utility for Windows 95 and Windows NT" Windows
Sources 3/96

"These days everyone needs a good unzipping utility. This is the best." PC Computing, 12/95



"Easy Archival" NetGuide 12/95
One of the "Essential Windows 95 utilities" Windows Magazine 12/95

"WinZip for Windows 95 is an absolute necessity for file uploads and downloads" PC Computing
11/95

"Here's good news: The best zipping and unzipping program you can find is available in a
Windows 95 version." Computer Shopper, 10/95

"Terrifically useful file compression tool" PC World, 10/95

"Windows 95 users get special treatment with the new version of WinZip" Windows Sources
10/95

"WinZip is extraordinarily handy and one of the best timesavers around" Computer Shopper 9/95

"WinZip 6.0 deftly integrates the best of the Windows ZIP utilities into the Windows 95
environment" PC Magazine, 9/12/95

"Recommended download" Windows Magazine 9/95
"Slash your online time" PC Computing, 8/95
"Internet file support adds strength to an already sturdy WinZip" Computer Shopper, 8/95

"Easy drag-and-drop interface when handling popular Internet file compression formats" Online
Access 6/95

"Point-and-click to open ZIP Files" Maximize 6/95

"For anyone dealing with large amounts of files ... WinZip is an invaluable utility" PC Magazine
UK, 6/95

"If | were stuck on a desert island with a notebook and a CompuServe account, the only utility I'd
want would be WinZip.", PC World 5/95

"WinZip compression program makes a great main squeeze" Knight-Ridder Newspapers 5/21/95



Quick Start Information

Whether you are an experienced user of Zip files or not, WinZip's intuitive interface can help you handle
all kinds of archives like a pro in no time at all. It includes a wide range of capabilities that you may or may
not want to use at this time, depending on your needs.

If you haven't installed WinZip yet, the section titled WinZip Installation contains some brief
instructions.

There are several ways to get to know WinZip quickly and easily, each tailored to a different style of
learning. Choose one or more of the following approaches

e Some users just like to dive right in! If you have experience with archives and Windows, you might
want to do just that. Context-sensitive help is available at any time by pressing the F1 key.

¢ You can get an overview of the primary operations of WinZip from the section titled Brief Tutorial.

¢ If you like to "learn by doing..."

Windows 95 users may like the WinZip Tutor Step by Step Instructions interactive help system
that takes users step by step through two basic features: unzipping and zipping up a sample zip
archive that is included for your convenience.

Windows 3.1 users can read through the Step by Step Example and follow the steps it
prescribes.

¢ The new WinZip Wizard is a series of panels or pages in a special window that help a user
through a task, commonly known as a "wizard." This new and convenient alternative interface for
WinZip can help to simplify unzipping and installing software.

Don't miss some of other topics of interest that can help you get started:

The section titled Windows 95 and NT 4.0 Quick Examples is of particular interest to Windows 95
and NT 4.0 users.

The section titled Drag and Drop Interface describes a useful WinZip feature. Be sure to give it a
try!
The section on Hints and Tips can provide dozens of helpful ideas for using WinZip.

For assistance in learning how to use the online help system, choose How to Use Help from
WinZip's Help menu.



About Zips And Other Archives

What is an Archive?

Archives are files that contain other files. Typically the files in an archive are compressed. Archives
usually have file names ending with ZIP, LZH, ARJ, or ARC, depending on how they were created.
Archives make it easy to group files and make transporting and copying these files faster.

Typical Uses for Archives:

Most files available in "file areas" on bulletin boards and electronic services like CompuServe and
the Internet are distributed as archives. Two benefits of using archives for electronic file
distribution are that only one file transfer operation ("download") is required to obtain all related
files, and file transfer time is minimized because the files in an archive are compressed. See the
sections titled Install/Try/Uninstall Feature and CheckOut Feature for information about WinZip
features particularly suited for working with downloaded files.

It is often useful to send a group of related files to an associate. Rather than distributing
individual files it is often easier to distribute the files as an archive to benefit from the file grouping
and compression.

Some files are important but not used often. To save disk space simply compress these files into
an archive when they are not used, and decompress them only when needed.

What is a Self-Extracting Zip File?

A self-extracting Zip file is an executable program file (.EXE file) that includes both a Zip file and
software to extract or "unzip" the contents of the Zip file. Users can extract the contents of a self-
extracting Zip file by simply running it. This is convenient, because the end user does not need
an unzip program (like WinZip) to extract files from these self-extracting archives.

WinZip Self-Extractor Personal Edition, included with WinZip, creates native Windows self-
extracting Zip files. You can also create self-extracting ARJ and LZH files. This, however,
requires external programs, as described in the section System Requirements.

Archive formats:

Zip files are the most common archive format. WinZip does not use external programs to work
with Zip files.

ARJ files are another popular archive format. ARJ files are manipulated by the ARJ program
from ARJ Software, P.O. Box 249, Norwood, Massachusetts 02062.

LZH files are manipulated by the LHA program from Haruyasu Yoshizaki. LHA won the October
1991 PC Magazine Editor's Choice award as the best data compression utility.

ARC is an older format. ARC files can be manipulated by several programs, including the
original ARC, ARCE (also known as ARC-E), PKXARC, and PKUNPAK. Since almost all new
archives are created in other formats and there is no single widely available program to
manipulate ARC files, WinZip does not provide facilities to add to ARC files (however, all other
WinZip functions are supported).

TAR, Z, GZ, TAZ, and TGZ files are often found on Unix-based Internet sites. The relationship
between these file types is less straightforward than the aforementioned file formats. The
important thing to remember is that WinZip handles all these formats the same way as Zip files,
so you don't need to know the details. Here is more information on these formats: TAR stands
for "Tape ARchive". This is an old file format and does not provide compression; it is used only
to group files. Z files are compressed with gzip or the older Unix "compress" program. GZ files
are gzip files. Z and GZ files cannot contain multiple files. TAZ and TGZ files are TAR files
compressed in "Z" or "GZ" format. Since almost all new archives are created in Zip format
WinZip does not provide facilities to add to or create files in these formats (however, all other
WinZip functions are supported). WinZip does not require external programs when working with
files in these formats.



e UUencoded, XXencoded, BinHex, and MIME files are used primarily to transfer binary files by
Internet e-mail. If you encounter one of these files, you can open it and extract its contents with
WinZip. You can UUencode an archive using the UUencode entry in the WinZip Actions pull-
down menu.

e WinZip also handles many files in the Microsoft Compress format (also known as LZEXPAND
format). However, there are several variations on this format, and Microsoft has not released
documentation on these variations. Therefore, you are limited to decompressing files supported
by your version of Windows (Windows for Workgroups supports some files not supported by
Windows 3.1). WinZip issues an appropriate message if you attempt to decompress a file not
supported by your version of Windows. Microsoft Compress files usually end with a trailing
underscore, for example, "commdlg.dl_". Like Z and GZ files, Microsoft Compress format files
contain only one file. This format is used for many files on your Windows 3.x distribution disks
and many other Microsoft products. Note that not all files ending with an underscore are
Microsoft Compress format files.

See the section titled System Requirements for more information on version numbers and availability of
the external programs supported by WinZip.



Step by Step Example

Windows 3.1 Only The Windows 95 Step by Step Examples are in the section titled WinZip
Tutor.

This section provides step by step examples of using WinZip. To print this section, click on Print Topic
in the Help window's File pull-down menu. Like the Brief Tutorial, this section assumes the following:

e Your system meets the requirements described in the section titled System Requirements and
you have installed WinZip as described in the section titled WinZip Installation.

¢ You know how to use standard Windows features, such as dialog boxes, menus, and the drag
and drop interface. If you are not are familiar with these features, please consult your Windows
documentation.

¢ You are familiar with the concept of archives. For a description of archives, see the section titled
About ZIPs And Other Archives.

If you follow the steps below you will create a new archive, add two files to the archive, view a file in the
archive, and extract the files in the archive to a new folder. This should give you a feel for using WinZip.
After following this example you will probably want to (re)read the section titled Brief Tutorial.

Be sure to follow these steps EXACTLY to ensure correct results. Rather than trying out interesting
options, just follow along to be sure you and the description below don't get "out of sync".

Unlike the Brief Tutorial, this section uses specific filenames. You can follow along by typing exactly what
is shown. However, since the author doesn't know what files exist on your system, you'll have to create a
folder and two test files with specific filenames before starting to work with "live" Zip files. The following
four steps detail this procedure. These steps involve using standard Windows features. For conceptual
information and details on the use of these four steps please consult your Windows documentation.
Meanwhile, be sure to follow these instructions exactly.

1 Create the C:\\FOO folder. If you already have a folder called C:\FOO you will have to substitute
a different folder name in the following examples. Create the folder as follows: start the File
Manager by double clicking on the File Manager icon in the Program Manager's "Main" group.
Select New Folder from the File Manager's File pull-down menu. Type the following:

c:\foo

Be sure to type a backwards slash as shown, not a normal forward slash! Then press the OK
button. Finally, close the File Manager (select Exit from the File Manager's File pull-down
menu).

2 Create the file C:\FOO\ONE.TXT as follows: start Notepad by double clicking on the Notepad icon
in the Program Manager's "Accessories" group. Type the following text into Notepad's main
window:
this is the first file

Next, save the file to disk by selecting Save As from Notepad's File pull-down menu. Type the
following filename:

c:\foo\one.txt

Then press the OK button.

3 Create the file C:\FOO\TWO.TXT as follows: replace the text in Notepad's main window with the
following text:

this is the second file
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Next, save the file to disk by selecting Save As from Notepad's File pull-down menu. Type the
following filename:

c:\foo\two.txt

Then press the OK button.
Close Notepad (select Exit from Notepad's File pull-down menu)

Now we will create an archive containing the two files you created in the previous step. Please be sure
to follow these instructions exactly:

1

Start WinZip by double clicking on the WinZip icon in the Program Manager's WinZip group.
Select Set Installation Defaults from WinZip's Options pull-down menu and reply Yes when
asked if you want to reset the installation defaults.

Select New Archive from WinZip's File pull-down menu. At this point you should see a dialog
box titled New Archive. This dialog box is where you specify the name of the archive you are
going to create. All the normal Windows techniques for changing the current folder and selecting
filenames will work, but for now, just type the following filename for your new archive

c:\foo\test.zip

Verify that the Add Dialog check box is checked. Then press the OK button.

At this point you should see a dialog box titled Add. This dialog box is where you specify the
names of the files you want to put into the archive. You can read detailed information about all
the fields in the Add dialog box by pressing the Help button, but please don't do that now!
Instead, follow these instructions exactly to be sure to stay in sync with the tutorial. As in the
New Archive dialog box, all the normal Windows techniques for changing the current folder and
selecting filenames will work, however, just type the following two filenames, separated by a
space:

one.txt two.txt

Verify that the Action drop-down listbox specifies Add, and press the Add button on the top right
of the dialog box. WinZip will add the two files to the archive TEST.ZIP created in the previous
step.

When the Add operation completes, you should see the main WinZip window, titled "WinZip -
C:TEST.ZIP", showing the two files you just added in the main listbox below the toolbar.

At this point you have successfully added two files to an archive. The files ONE.TXT and TWO.TXT exist
in two places: in the c:\foo folder where you originally created them, and in the archive c:\foo\test.zip.

Next we will view one of the two files in the archive.

1

2

3

In WinZip's main window double click on the line that starts with TWO.TXT. WinZip will
automatically start the appropriate program to view the file TWO.TXT. In most cases this will be
Notepad.

At this point Notepad (or another viewer) should be running. The active window should be titled
something like "Notepad - ONE.TXT". The main window will show the text you typed at the
beginning of this example.

When you are done viewing the file, select Exit from the viewer's File pull-down menu and
activate the main WinZip window.

Finally, we will extract the files to a new folder. While this operation is redundant in this example
(because you already have the files in the C:\FOO folder) it is a useful technique when you receive
archives created elsewhere, for example, from an associate or an online service.



In this example we'll extract the files in TEST.ZIP to the C:\BAR folder. If you already have a folder called
C:\BAR you will have to substitute a different folder name in the following examples.

1 Select Extract from WinZip's Actions pull-down menu. At this point you should see a dialog box
titled Extract.

2 In the Extract To field type the following
c:\bar

Click the All Files radio button to tell WinZip to extract all files in the archive to the c:\bar folder.

3 Press the Extract button at the top right of the dialog box. The folder C:\BAR will be created,
and both files in the archive will be extracted from TEST.ZIP to the C:\BAR folder.

4 When the extract operation completes, the main WinZip window will once again be active.
Select Exit from WinZip's File pull-down to close WinZip and conclude this example.

At this point you have created an archive, added two files to the archive, viewed a file in the archive, and
extracted the files in the archive to a new folder. The files ONE.TXT and TWO.TXT exist in three places:

In the folder c:\foo, where you originally created them.
In the archive c:\foo\test.zip, because you added them to the archive.
In the folder c:\bar, because you extracted them.

You may want to delete the c:\foo and c:\bar folders using the File Manager, since you no longer need
these folders or the files they contain.

Important: there are many faster ways to work with WinZip and archives! These examples were
complicated by an attempt to use known filenames and dependencies on the folders already on your hard
disk. In particular, be aware of the following:

1 Rather than typing fully qualified filenames like c:\foo\one.txt you can almost always avoid typing
the drive and folder by clicking in the Folder list boxes in the New Archive, Add, and Extract
dialog boxes.

2 You can avoid typing existing filenames in the Add dialog box by clicking on the filenames in the
Files list box. For information on selecting multiple files at once see the section titled Using
Extended Selection List Boxes.

3 You can go even further by using drag and drop. See the section titled Drag and Drop Interface
for more information on this very useful feature.

Don't forget: press the F1 key or the Help button in any WinZip dialog box to get context sensitive help.



Downloading and Processing Files with WinZip

WinZip has special features that make it simple and convenient to download and process compressed
files from the Internet and online services like America Online and CompuServe.

Click to choose the method about which you would like to learn more:
Downloading From The Internet
Downloading From America Online, CompuServe, And Other Online Services



Downloading From The Internet

You can use WinZip to work with archives you download from the Internet just as you do with other
archives, or you can use the free Internet Browser Support Add-On to simplify your work with Internet
downloads, as described below.

The free WinZip Internet Browser Support Add-On will automate much of the
work normally associated with downloading compressed files from the Internet. When you click
on an archive using Netscape Navigator/Communicator or Microsoft Internet Explorer, WinZip will
take over when the download is completed. WinZip automatically moves the downloaded file to
your download folder (initially set to c:\download) and then opens the file. This add-on is
available for download from the web page http://www.winzip.com/ibrowser.cgi (this free add-on is
not part of the WinZip distribution package).

If you download an archive without the add-on the current versions of Microsoft
Internet Explorer and Netscape Navigator/Communicator will give you a choice of opening the
archive or saving it to disk. If you choose to open the archive, you should be aware that the
Internet Browser will probably delete the file when the browser is closed. To avoid this problem,
use the Internet Browser's "save to disk" option, and specify an easy-to-remember folder, for
example, c:\download.

Problems Downloading? When you download a file, many things can go wrong, resulting in a damaged
copy of the file that WinZip cannot open. The solution to most download related problems is simply
to download the file again. For more information on resolving Internet download related problems,
please check the web page http://www.winzip.com/downprob.htm.

Note:

Many files available for download on the Internet are executable (.exe) files. The WinZip Internet
Browser Support Add-On will not try to handle these files. However, if the .exe file is a self-extracting Zip
file, you can open and process it using the WinZip Classic File->Open dialog box, or under Windows 95
and NT, by right-clicking on the file and selecting "Open with WinZip".

Related Topics:
Downloading from America Online, CompuServe, and other online services



Downloading from America Online, CompuServe, And Other
Online Services

An online service with its own access software will generally have a specific folder on your computer
where newly downloaded files are placed. For example, America Online uses a folder named c:\aol\
download, and CompuServe uses a folder named c:\cserve\download. After you download a Zip file from
one of these services in the normal manner, it's easy to use WinZip to open and process the file.

If you use the WinZip Wizard Interface, start WinZip by clicking on its icon, then click
the Next button to move to the Select Zip File screen. The WinZip Wizard's Select Zip File
screen shows all the Zip files in your Favorite Zip Folders with the most recently downloaded files
at the top of the list, along with the folder in which they are located.

If your file or the special download folder is not shown, you can have WinZip search for the item
by clicking on the Search button, then clicking Search hard disk(s) on this PC, and then clicking
OK. WinZip will check all your hard drives and make a new list of Zip files, and update your
favorite folders (the places where WinZip has found Zip files stored on your PC). When the
process is complete, newly downloaded files should be near or at the top of the list. Highlight the
file you wish to work with to continue with the Wizard's unzipping process.

See the section titled WinZip Wizard for details on using the Wizard.

If you use the WinZip Classic Interface, start winzip by clicking on its icon, then click
"Favorites" toolbar button or select "Favorite Zip Folders" from the File pull-down menu. The
resulting dialog box shows all the Zip files in your Favaorite Zip Folders with the most recently
downloaded files at the top of the list, along with the folder in which they are located.

If your file or the special download folder is not shown, you can have WinZip search for the item
by clicking on the Search button, then clicking Search hard disk(s) on this PC, and then clicking
OK. WinZip will check all your hard drives and make a new list of Zip files, and update your
favorite folders (the places where WinZip has found Zip files stored on your PC). When the
process is complete, newly downloaded files should be near or at the top of the list. Highlight the
file you wish to work with, then click the Open button.

See the section titled Hints For Working With Downloaded Files for more suggestions.

Note: Many files available for download on the Internet are executable (.exe) files. WinZip's Internet
Browser Support will not try to handle these files. However, if the .exe file is a self-extracting Zip file, you
can open and process it using the WinZip Classic File->Open dialog box, or under Windows 95 and NT,
by right-clicking on the file and selecting "Open with WinZip".

Related Topics:
Downloading from the Internet



Hints for Working With Downloaded Files

WinZip makes it easy to work with files downloaded from Internet, bulletin boards, and online services like
America Online and CompuServe.

e The WinZip Internet Browser Support Add-On adds features to work hand in hand with Netscape
Navigator/Communicator or Microsoft Internet Explorer.

e Favorite Folders makes locating Zip files you want to open much easier.

¢ Downloading and Processing Files with WinZip provides further hints, tips, and helpful
procedures.

e The Install/Try/Uninstall Feature and CheckOut Feature are particularly useful for trying files that
are downloaded.

e Archive Management features make it easy to move archives to floppies, or even to delete them if
they don't meet your needs.

To print this page, click on Print Topic in the Help window's File pull-down menu.
One strategy for handling downloaded files involves three folders:

\DOWNLOAD recently downloaded files
\UPLOAD files you are planning to upload
\ARCHIVES archives you are planning to keep

A relatively empty download folder makes it much easier to stay organized. It is a good idea to download
all archives into your \DOWNLOAD folder, and after each on-line session perform the following steps for
each archive:

1. Open the archive. An easy way to open files is to first activate the File Manager or Explorer and
view the \DOWNLOAD folder. Then double click on an archive to openit. You will probably
want to select Sort By Date from the File Manager's View pull-down menu or click on the
Modified column header in the Explorer so that the most recent files are shown at the top of the
list.

2. Read about the software in the archive. Many archives contain a file named "file_id.diz". By
convention this file contains a brief description of the archive contents. If this file is listed in the
main WinZip window, double click on it to view its contents. When you are done viewing the file
close the program being used to view the file. Repeat this process for any files with the word
"read" in the filename (e.g. "readme.txt" or "read.me").

3. Try the software if the archive looks interesting. One easy way to do this is with the Install or
CheckOut button on WinZip's toolbar. If the archive contains an "install" or "setup" program, the
Install button will be displayed, otherwise, it will contain the CheckOut button. For details on
these features see the sections titled Install/Try/Uninstall Feature and CheckOut Feature. Note:
downloaded software should always be scanned for viruses before you install or use it. If
you download archives containing software, you should obtain a reliable virus scanner, keep it up
to date, and always use it on the contents of such downloaded archives. See the section titled
Virus Scanner Configuration for information on configuring WinZip to use your virus scanner to
test the contents of archives for virus infection.

4. Move each archive out of your download folder after trying the software. If you want to keep the
archive on your hard disk select Move from the File menu to move the archive into your \
ARCHIVES folder, or, if you want to post the archive on another BBS, move it into your \UPLOAD
folder. Note that the folders you have most recently used for move and copy operations are
available for quick access in a drop-down list. If you don't want to keep the file you downloaded
you can easily move it to a floppy or delete it using the Delete entry in the File pull-down menu.

Of course, these are just suggestions. There are other good ways to use WinZip to work with downloaded
files. Feel free to use whatever method works best for you.



Related Topics:

Hints and Tips

More Hints and Tips

Frequently Asked Questions (FAQs
Windows 95 and NT 4.0 Quick Examples



System Requirements

The 32-bit version of WinZip, requires Windows 95 or Windows NT 4.0. It will not run under Windows NT
3.1 0r 3.5.

The 16-bit version of WinZip requires Windows 3.1 or later.

For information on OS/2 see the section titled Running WinZip under OS/2. WinZip is known to be
incompatible with a DOS TSR called "BUFFIT.COM".

No other programs are required to add or extract files from Zip files. However, some WinZip
operations do require external programs or files:

e Optional virus scanning support requires that a supported virus scanning program be installed on your
system. See below for a list of virus scanners automatically detected by WinZip.

e Optional ARC, ARJ, and LHA support requires one of the supported programs listed below. For step
by step instructions on installing these programs see the section titled Installing Optional External

Programs.
Here are more details on some of the optional programs:
¢ To create self-extracting Zip files one of three programs is needed.
e WinZip Self-Extractor Personal Edition, included with WinZip, is automatically installed along
with WinZip.

e The full WinZip Self-Extractor, a $49 add-on, includes features tailored for software
distribution, and the ability to create a single self-extracting Zip file that can be run under
either MS-DOS or Windows.

e |f you want to create MS-DOS text mode self-extracting Zip files and have a distribution
license for ZIP2EXE from PKWARE®, you can use ZIP2EXE. Please be sure to read the
ZIP2EXE license agreement before distributing files created with this program.

e To access LZH files the LHA.EXE program from Haruyasu Yoshizaki is required. You can
download LHA.EXE from most bulletin boards. The latest version is distributed in the self-
extracting LZH file LHA213.EXE. WinZip has been tested with LHA 2.13 and will not work with
earlier versions (in particular, it will not function with LHARC, the predecessor to LHA).

e To access ARJ files the ARJ program from Robert Jung is required. You can download the
Shareware version of ARJ from most bulletin boards. The latest version is distributed in the self-
extracting ARJ file ARJ250.EXE. WinZip has been tested with ARJ 2.30-2.50 and will not work
with earlier versions.

To access ARC files one of the following programs is required:

e ARCE.COM and ARC-E.COM version 4.0e - Vern Berg's ARC extraction utility, available on
CompuServe and other bulletin boards. WinZip was not tested with earlier versions.

¢ PKXARC.COM version 3.5 from PKWARE, Inc. WinZip was not tested with earlier versions.
This program is still available on some bulletin boards.

e PKXARC.EXE version 3.6 from PKWARE, Inc. This program is still available on some bulletin
boards.

e PKUNPAK.EXE version 3.61 from PKWARE, Inc. This program is still available on some bulletin
boards.

e ARC.EXE version 5.20 or 6.0 from System Enhancement Associates, Inc. This is the last
version of ARC available as Shareware, and is still available on some bulletin boards. WinZip
was not tested with earlier versions. SEA's address is 925 Clifton Ave., Clifton, NJ 07013.

WinZip will automatically detect the following virus scanners:
e NAVWNT, NAVW and NAV, from Symantec



¢ WNAPVIR and CPAYV, distributed with Central Point Desktop For Windows
e MSAV, distributed as part of MS-DOS 6.0

¢ SCAN and WSCAN, from McAfee Associates

e F-PROT, from Frisk Software International

e Dr. Solomon's Anti-Virus Toolkit, from S&S International

e ThunderByte's TBSCAN, from ESaSS B.V.

WinZip can also be configured to work with most virus scanning utilities. For important details, see the
section titled Virus Scanner Configuration.

Note: Like WinZip, ARJ, ARC, PKXARC, F-PROT, TBSCAN, and SCAN programs are not free software.
As with all shareware, if you use these programs you should register them with the appropriate vendor.
Dr. Solomon's Anti-Virus Toolkit and the NAVW and WNAPVIR programs are commercial programs, not
shareware.



WinZip-Related Files

Filename
README.TXT

WINZIP.TXT
WINZIP.EXE
WZzZ.DLL
Wz2.DLL
WZUU16.DLL
WINZIPFM.DLL
WINZIP.HLP
WZSEPE16.EXE
WZSEPE32.EXE
WZWIZARD.HLP
EXAMPLE.ZIP
WZTUTOR.HLP
WINZIP.CNT
WINZIP32.EXE
WZSHLEXT.DLL

WZFM32.DLL
WZ.COM

WZ.PIF
LICENSE.TXT
ORDER.TXT
VENDOR.TXT
WHATSNEW.TXT
FILE_ID.DIZ

Description
introductory information

extracts from online documentation

required executable (Windows 3.1 version only)

required dynamic link library (Windows 3.1 only)

required dynamic link library (Windows 3.1 only)

required dynamic link library (Windows 3.1 only)

File Manager Extension dynamic link library

documentation in online hypertext help format

WinZip Self-Extractor Personal Edition (Windows 3.1 only)
WinZip Self-Extractor Personal Edition (Win32 version only)
documentation for the Wizard interface

example file used by tutorial (Win32 version only)
documentation for Windows 95 tutorial (Win32 version only)
help contents file (Win32 version only)

required executable (Win32 version only)

Windows 95 Explorer Shell Extension dynamic link library (Win32 version
only)
File Manager Extension dynamic link library (Win32 version only)

required executable

required Program Information File

license agreement/warranty

order form

information for Shareware Distributors and Disk Vendors
list of recent changes

brief description for bulletin boards

WinZip Installation

To install WinZip from the distribution disk, follow one of these procedures:

e Windows 95 Users: choose Run from the Start menu, type a:setup, and press the Enter key.

e Windows 3.1 Users: from the Windows Program Manager choose Run from the File menu, type
a:setup, and press the Enter key.

The Setup program will issue a number of prompts. Unless you have a reason to override the defaults it
is strongly recommended that you accept the installation default settings (just press OK, Yes, or Next, as

appropriate).



WinZip Uninstallation

Under Windows 95 and Windows NT 4.0 you can uninstall WinZip from the Control Panel Add/Remove
Applications window. Activate the Control Panel, double click Add/Remove Programs, and double click
on the WinZip list box entry.

Under Windows 3.1 you can uninstall WinZip by double clicking on the "Uninstall WinZip" icon in the
WinZip program group.

Additional information:

You can also uninstall WinZip by running WINZIP32.EXE (under Windows 3.1 run WINZIP.EXE instead)
and specifying the /uninstall parameter. For example, if WinZip is installed in your c:\winzip folder, in the
Run dialog box, type

c:\winzip\winzip32.exe /uninstall
Technical details:
The "Uninstall WinZip" procedure performs the following steps:
e \Verify it is safe to uninstall
¢ Remove WinZip File Manager Extension from WINFILE.INI if it is installed

¢ Delete files in WinZip folder if they were installed by this version of WinZip and if the file's
date/time stamp matches WINZIP32.EXE (under Windows 95 and Windows NT) or WINZIP.EXE
(under Windows 3.1). The WINZIP.GID, WINZIP.FTS, and WINZIP.PIF files are deleted
regardless of their date/time stamp.

e Remove any WinZip file associations from WIN.INI

e Remove [WinZip] entry from WIN.INI

e Remove the WinZip icons and program group

¢ Remove the WinZip entries from the registration database



Installing Optional External Programs

WinZip includes built-in ZIP and UNZIP, so no other programs are required for most WinZip operations.
However, virus scanning and operations involving ARC, ARJ, and LZH files require external programs.
These optional external programs are not distributed with WinZip. You must tell WinZip where to find

these programs as described in the section titled Program Locations. This following sections provide

step by step examples of how to install LHA and ARJ.

Remember: the use of these external programs is optional. If you are just getting started with WinZip
you will probably want to skip this section and work without the external programs until you encounter a
need for them (and are more familiar with WinZip).

These instructions assume you are comfortable working with the Windows File Manager or Explorer,
know how to use standard Windows features such as dialog boxes and menus, and have a little
experience using WinZip. See the section titled Quick Start for introductory information and how to
quickly become familiar with WinZip.

Note: The first step in installing an external program is to acquire the external program. See the section
titled System Requirements for information on obtaining these programs.

Related Topics:
Installing LHA
Installing ARJ



Installing LHA

Here are step by step instructions for installing LHA, an optional external program required to work with
LZH files.

1.

LHA is distributed as a self-extracting archive called LHA213.EXE. First download LHA213.EXE
from your favorite online service.

Use the File Manager or Explorer to create the folder C:\LHA. You can use a different folder but
then you will need to substitute that folder name in the following instructions.

Use the File Manager or Explorer to copy LHA213.EXE from your download folder to the C:\LHA
folder.

Double click on LHA213.EXE to runit. This will cause the files in LHA213.EXE to "self-extract"
into the C:\LHA folder. Then go back and delete C:\LHA\LHA213.EXE, as it is not needed for
day-to-day work with LHA and WinZip.

Start WinZip. Pull down the Options menu and select Program Locations.
In the LHA field in the Program Locations dialog box type

c:\Iha\lha.exe

and press the OK button.

That's all there is to installing LHA. You can now access .LZH files (created by LHA) the same way you
access Zip files.



Installing ARJ

Here are step by step instructions for installing ARJ, an optional external program required to work with
LZH files.

1.

ARJ is distributed as a self-extracting archive called ARJ250.EXE. First download ARJ250.EXE
from your favorite online service.

Use the File Manager or Explorer to create the folder C:\ARJ. You can use a different folder but
then you will need to substitute that folder name in the following instructions.

Use the File Manager or Explorer to copy ARJ250.EXE from your download folder to the C:\ARJ
folder.

Double click on ARJ250.EXE to run it. This will cause the files in ARJ250.EXE to "self-extract”
into the C:\ARJ folder. Then go back and delete C:\ARJ\ARJ250.EXE, as it is not needed for
day-to-day work with ARJ and WinZip.

Start WinZip. Pull down the Options menu and select Program Locations.
In the ARJ field in the Program Locations dialog box type

c:\arj\arj.exe

and press the OK button.

That's all there is to installing ARJ. You can now access .ARJ files the same way you access Zip files.
Note: Like WinZip, ARJ is not free software. As with all shareware, if you use these programs you should
register them with the appropriate vendor. See the license.doc file in your ARJ folder for details.



Copyright/License/Warranty

WinZip® Copyright © 1991-1997 by Nico Mak Computing, Inc.
All rights reserved.

License Agreement

You should carefully read the following terms and conditions before using this software. Unless you have
a different license agreement signed by Nico Mak Computing, Inc. your use of this software indicates your
acceptance of this license agreement and warranty.

For information on distributing the evaluation version of WinZip see the section titled Evaluation License.

Registered Version

One registered copy of WinZip may either be used by a single person who uses the software personally
on one or more computers, or installed on a single workstation used nonsimultaneously by multiple
people, but not both.

You may access the registered version of WinZip through a network, provided that you have obtained
individual licenses for the software covering all workstations that will access the software through the
network. For instance, if 8 different workstations will access WinZip on the network, each workstation
must have its own WinZip license, regardless of whether they use WinZip at different times or
concurrently.

WinZip Self-Extractor Personal Edition, included with WinZip, may be used at workstations licensed to
use the registered version of WinZip to create an unlimited number of freely distributable royalty-free self-
extracting ZIP files. Self-extracting ZIP files created by WinZip Self-Extractor Personal Edition contain,
among other things, a portion of WinZip Self-Extractor, including copyrighted software, proprietary
notices, and identifying information (the "Extraction Software"). No registered user may alter or modify
the Extraction Software. You cannot give anyone else permission to modify the Extraction Software.

Governing Law

This agreement shall be governed by the laws of the State of Connecticut.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT
WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES
WHETHER EXPRESSED OR IMPLIED. In particular, there is no warranty for the optional virus scanning
feature (WinZip does not scan for viruses, it simply runs external programs that claim to perform this
function). Because of the various hardware and software environments into which WinZip may be put,
NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data
before relying on it. The user must assume the entire risk of using the program. ANY LIABILITY OF
THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF
PURCHASE PRICE.



Evaluation License

See the section titled Copyright/License/\Warranty for the full license agreement.
Evaluation and Registration

This is not free software. Subject to the terms below, you are hereby licensed to use this software for
evaluation purposes without charge for a period of 21 days. If you use this software after the 21 day
evaluation period a registration fee of $29 is required. Payments must be in US dollars drawn on a US
bank, and should be sent to Nico Mak Computing, Inc., P.O. Box 540, Mansfield, CT 06268. Credit card
ordering and quantity discounts are available, as described in the section Ordering Information/Order
Form. When payment is received you will be sent a registered copy of the latest version of WinZip.

Self-extracting ZIP files created by WinZip Self-Extractor Personal Edition (distributed as part of the
WinZip evaluation package) contain, among other things, a portion of WinZip Self- Extractor, including
copyrighted software, proprietary notices, and identifying information (the "Extraction Software"). You
may not alter or modify the Extraction Software and cannot give anyone else permission to modify the
Extraction Software. UNDER NO CIRCUMSTANCES ARE YOU LICENSED TO DISTRIBUTE SELF-
EXTRACTING ZIP FILES CREATED BY THE EVALUATION VERSION OF WINZIP SELF-EXTRACTOR
PERSONAL EDITION.

Unregistered use of WinZip or WinZip Self-Extractor Personal Edition after the 21-day evaluation period is
in violation of U.S. and international copyright laws.

Distribution

Provided that you verify that you are distributing the evaluation version (select About from the WinZip
Help menu to check) you are hereby licensed to make as many copies of the evaluation version of this
software and documentation as you wish; give exact copies of the original evaluation version to anyone;
and distribute the evaluation version of the software and documentation in its unmodified form via
electronic means. There is no charge for any of the above.

You are specifically prohibited from charging, or requesting donations, for any such copies, however
made; and from distributing the software and/or documentation with other products (commercial or
otherwise) without prior written permission.



Ordering Information

All WinZip licenses cover the Windows 95/NT and Windows 3.1 versions; disk orders include both
versions on a 3.5 inch disk and will be shipped by postal mail (air mail if you are overseas) within two
business days after they are received. All prices include shipping.

Customer information is considered confidential and will not be shared or distributed to any third party.
All orders are subject to the WinZip License Agreement.
Immediate Online Delivery

Immediate online delivery of registered copies of WinZip is available for credit card orders placed via the
Internet using the Order link on the WinZip home page: http://www.winzip.com. You can place orders
for delivery by postal mail (or airmail outside the USA) using the Internet order forms or as described
below.

Ordering by Check

To order by check, send the order form and a check to Nico Mak Computing, Inc., P.O. Box 540,
Mansfield, CT 06268-0540 USA. Payments must be in US dollars drawn on a US bank, or you can send
international postal money orders in US dollars. Click here to view a ready-to-print Order Form.

Credit Card Orders

You can place secure credit card orders on the Internet using the Order link on the WinZip home page at
http://lwww.winzip.com. For information on credit card ordering by phone, fax, e-mail, or postal mail,

click here: Credit Card Ordering.
CompuServe Registration

For information on having the registration fee added to your CompuServe bill, click here: CompuServe
SWREG Ordering.

Purchase Orders

For information on using purchase orders click here: Purchase Orders.

Ordering Options Outside the USA and Canada

For information on local registration click here: Ordering Options Outside the USA and Canada.
Site licenses

A site license for WinZip entitles an organization to receive one copy of the distribution package and to
duplicate the distribution disk for the specified number of copies. See the table below for site license
pricing. For higher quantity pricing, please send e-mail to sitesales@winzip.com.

Pricing
WinZip Single Copy $29 each
WinZip Site Licenses:
2 to 9 computers: $22 each
10 to 24 computers: $17 each
25 to 49 computers: $14 each
50 to 99 computers: $10 each

100 to 199 computers: $7 each
200 to 499 computers: $6 each
500 to 999 computers: $4 each

Connecticut residents please add 6% sales tax.
Prices guaranteed through August, 1998.






WinZip® 6.3 Order Form/Invoice

To print this order form, select Print Topic from the File pull-down menu.

To order by check, send this order form and a check to Nico Mak Computing, Inc., P.O. Box 540,
Mansfield, CT 06268-0540 USA. Payments must be in US dollars drawn on a US bank, or you can send
international postal money orders in US dollars.

All orders are subject to the WinZip License Agreement. Prices guaranteed through August, 1998.

Note: this ordering information is for the English version of WinZip. Both Windows 95 and Windows 3.1
versions are included on a 3.5 inch disk.

Customer information is considered confidential and will not be shared or distributed to any third party.

WinZip Single Copy _at $29each=
WinZip Site Licenses:

2to9 computers: __ at $22 each =

10 to 24 computers: __ at $17 each =

25to0 49 computers: __ at $14 each =

50to 99 computers: _ at $10 each =

100 to 199 computers: _ at $7 each =

200 to 499 computers: _ at $6 each =

500 to 999 computers: at $4 each =

Connecticut Residents add 6% sales tax:
Total payment:

Date:

Name:

Company:

Shipping Address:

City, State, Zip:

Country:

Day Phone:

E-Mail address:

How did you hear
about WinZip?

Comments:

WinZip® 6.3 Credit Card Order Form

To print this order form, select Print Topic from the File pull-down menu.
You can place credit card orders by phone, fax, e-mail, or postal mail through PsL, a credit card ordering



service. The best way to reach PsL is by fax to 1-713-524-6398 or by Internet mail to
71355.470@compuserve.com. You can also call PsL at 1-800-242-4PsL(4775) or 1-713-524-6394
between the hours of 8:30 am and 5:00 pm CST Monday-Friday, except holidays. You can send credit
card orders via postal mail to PsL at P.O. Box 35705, Houston, TX 77235 USA. Please be sure to include
a completed credit card order form (below) with your order.

Note: this ordering information is for the English version of WinZip. All orders are subject to the WinZip
License Agreement. Prices guaranteed through August, 1998.

Nico Mak Computing, Inc. cannot be reached at the numbers above. These numbers are
for PsL, a third-party service which only takes credit card orders.

Any questions about the status of the shipment of an order, refunds, registration options, product details,
technical support, volume discounts, dealer pricing, site licenses, etc., should be directed to Nico Mak
Computing. You can send Internet mail to help@winzip.com; our goal is to respond to all e-mail inquiries
within one business day. You can also send postal mail to Nico Mak Computing, P.O. Box 540, Mansfield,
CT 06268, USA.

WinZip Single Copy _at $29each=
WinZip Site Licenses:

2to9 computers: __ at $22 each =

10 to 24 computers: _ at $17 each =

25to 49 computers: _ at $14 each =

50 to 99 computers: _ at $10 each =

100 to 199 computers: _ at $7 each =

200 to 499 computers: _ at $6 each =

500 to 999 computers: at $4 each =

Connecticut Residents add 6% sales tax:

Total payment:
Date:

Credit Card: [ ]MasterCard [ 1VISA [ TAMEX [ 1
Discover

Credit Card #:
Expiration Date:
Name On Card:

Signature:

Name:

Company:
Billing Address:
City, State, Zip:

Country:

Day Phone:

E-Mail address:
How did you hear about
WinZip?




Purchase Orders

Purchase orders (net 30 days) are accepted from government and accredited educational institutions and
major corporations, provided that they are submitted on purchase order forms with a purchase order
number. Please be sure to include the standard WinZip order form with your purchase order, and send it
to Nico Mak Computing, P.O. Box 540, Mansfield, CT 06268 USA, or fax it to 1-860-429-3542..



CompuServe SWREG Ordering

Use the CompuServe command GO SWREG and follow the menus to register one of the product IDs
listed in the table below.

Detailed instructions for CompuServe for Windows users: select Go from the Access menu (WinCIM
users, select Go from the Services menu), then type SWREG. Double click on "Register Software" in the
Shareware Registration box. After viewing the Registration Agreement, click on Proceed, then select
your Geographic Region. Double click on ID # in the Register Shareware box and enter one of the

following IDs:

ID Product Price

402 Single Copy $29

4628 2-9 computer site license $22 each computer
4629 10-24 computer site license $17 each computer
4630 25-49 computer site license $14 each computer

Now double click on "Display Selected Titles" and then double click on the appropriate entry. Click on
Description to see a description of WinZip. You can now click the Register button to fill in your order
information. You will receive a confirmation by e-mail within one business day.



Ordering Options Outside the USA and Canada

In addition to the aforementioned registration options you can contact the following distributors for local
registration and support. Dealer prices may vary.

German Users: For a German language version of WinZip, please contact Top Systems GmbH,
Zeppelinstrasse 42, D-47638 Straelen, 2834-9332-0, e-mail support@winzip.de.

Japanese Users: Contact P&A Co., Ltd., of Japan, 1-3-6-2 Kamisuna, Tachikawa, Tokyo, Japan 190,
phone: 0425-35-9901, fax: 0425-35-9902, for local registration.

French Users: Contact AB Soft, Park Burospace #14, 91572 Bievres Cedex, France, phone 33-1-69-
33-70-00 for a French version of WinZip.

Other International Users: You can order directly from Nico Mak Computing, Inc, as described above, or
can contact ASi for the name of the nearest ASi reseller at 513-885-2031, fax 513-885-2032.

If you purchase WinZip directly from Nico Mak Computing, be sure to contact Nico Mak Computing for
support, not your local reseller.



Support and Questions

To check whether you have the most recent version of WinZip, please check the WinZip home page at
http://lwww.winzip.com, send e-mail to support@winzip.com, or download the file winzip.txt from the
"WinZip Support" library in the GO WINZIP area on CompuServe.

Please see the section titled Frequently Asked Questions for answers to common questions.

Technical support is available at no charge as described below. The best way to report problems is with
the support forms available from the "Support" link on the WinZip home page (http://www.winzip.com).
You can also send electronic mail to support@winzip.com on the Internet, to 70056,241 on CompuServe,
or send postal mail to Nico Mak Computing, Inc., P.O. Box 540, Mansfield CT 06268, or post a message
in the "WinZip Support" section in the GO WINZIP area on CompuServe.

There is an active group of WinZip users in the "winzip" conference on the CiX information network in the
U.K. You can post questions and comments, hear from other WinZip users, and download the most
recent WinZip releases from this conference.

When reporting problems, please include the following information:

1)
2)

3)
4)

5)

Is the problem reproducible? If so, how?

What version of Windows are you running? For example, Windows 3.1, Windows for
Workgroups, Windows NT 4.0, etc.

What version of WinZip are you running? Select About WinZip from the WinZip Help pull-down
menu. Please include the entire "version" line in your problem report.

If a dialog box with an error message was displayed, please include the full text of the dialog
box, including the text in the title bar.

If the problem involves an external program like LHA.EXE or SCAN.EXE, what version of the
failing program are you using? Please see the section titled System Requirements for minimum
version numbers for these programs.

Note: You can press F1 at any time while WinZip is active for context sensitive help.
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Windows 95 and NT 4.0 Features

For quick hints on using Windows 95 features see the section titled Windows 95 and NT 4.0 Quick
Examples.
This 32-bit version of WinZip includes the following Windows 95 and Windows NT 4.0 features:

Extract files by dragging them to a folder in the Explorer (or even to the desktop).
View files by dragging them to an application or a shortcut to an application.
Print files by dragging them to a printer or shortcut to a printer.

Extract an archive to any folder via drag and drop without leaving the Explorer. Use the right
mouse button to drag and drop a Zip from an Explorer window to any folder, then choose "Extract
to" from the context menu. Remember to use the RIGHT mouse button while dragging.

Add files to an archive without leaving the Explorer. Select files in the Explorer and drag and
drop them on a Zip file in the active Explorer window, in another Explorer window, or to a Zip file
on the desktop.

Add selected files to a Zip directly from the Explorer with complete control over the options:
RIGHT-click on any file (or selected group of files) in the Explorer and choose "Add To Zip" from
the context menu. This provides a function similar to the Add entry in the WinZip File Manager
Extension.

Create archives in the Explorer (or on the desktop) by RIGHT-clicking on the desktop and
choosing "WinZip File" from the "New" context menu entry. You can then add files to the new
archive as described above.

Explorer-style mini-icons are displayed next to files in an archive to help identify the file type.
Explorer-style Add dialog box.

The Delete Archive operation moves archives to the Recycle Bin rather than permanently deleting
the archive (you can hold down the shift key to override this behavior).

The Rename, Copy, and Move operations use the Windows 95 "overwrite" user interface.
Zips opened with WinZip are properly added to the Start Menu->Documents menu.
Explorer-style New and Open dialog boxes.

Extract files from a Zip in the Explorer by right-clicking on the Zip and choosing "Extract To" from
the context menu.

Uninstall WinZip using Control Panel->Add/Remove Applications.

WinZip uses the correct colors if you change color schemes. The WinZip toolbar buttons and
status line colors will match the rest of your desktop.

Windows 95-style tree-view help Contents window makes it easier to find help topics.

The WinZip Options/Explorer Configuration dialog box lets you add WinZip to the Start menu and
Desktop.

The File/Create Shortcut menu entry creates a desktop shortcut for the open archive.
WinZip includes 256 color 32x32 and 48x48 icons.
Long filename support and Universal Naming Convention support.

The "Uninstall" portion of the "Install/Try/Uninstall" feature is not currently implemented under Windows
95, however, a pre-release version of this feature is available for download from the WinZip home page
(www.winzip.com) and the "WinZip Beta" library in the GO WINZIP area on CompuServe.

Known problems under Windows 95:

A few people have reported problems running the optional external DOS programs while using
16-bit Windows video drivers. By now almost all video vendors have released Windows 95



drivers; installing the appropriate driver will solve this problem.

e The Windows 3.1 version of the Norton "FileAssist" program is incompatible with WinZip under
Windows 95. To solve this problem, either install Norton Navigator for Windows 95, or configure
FileAssist not to try to change WinZip dialog boxes.

Long Filename Notes:

e The current versions of all optional external archivers used by WinZip are DOS programs and do
not support long filenames. Therefore, WinZip will pass the short 8.3 version of all long file and
folder names to these external programs. Since normal 8.3 names are usually more meaningful
than the shortened versions of long filenames, it is recommended you use standard 8.3 filenames
when working with external archivers.

¢ Long Name Caution: DOS and 16-bit Windows programs usually have trouble with long
filenames and files with spaces in the name. Therefore, it is recommended that you do not use
long filenames and files with spaces in the name if you plan to work with these files from DOS.
For example, LHA.EXE will extract the file "A Long Filename" as "A LONG F", ignoring the extra
characters. To avoid this problem check the Store Filenames in 8.3 Format checkbox in the
Drop dialog box when adding files.

Additional Windows 95 enhancements are planned for the next version of WinZip. For information on the
latest version of WinZip, visit the WinZip home page at www.winzip.com or send Internet e-mail to
info@winzip.com. CompuServe users can use the command GO WINZIP and download the file
winzip.txt from the "WinZip Support" library.



Windows 95 and NT 4.0 Quick Examples

Here are some quick examples of the Windows 95 and Windows NT 4.0 features.

Using drag and drop from the main WinZip window:
¢ To extract a file: drag a file to a folder listed in any Explorer window.
¢ To view a file: drag a file to the appropriate application window or to a shortcut to the application.
e To print a file: drag a file to a printer or a printer shortcut.

Using the Explorer:

¢ To extract all files in a Zip without leaving the Explorer: use the RIGHT mouse button to
drag and drop a Zip file from an Explorer window to any folder, then choose "Extract to" from the
context menu. Be sure to use the RIGHT mouse button while dragging.

e To add files to a Zip without leaving the Explorer: just select one or more files in the Explorer
and drag and drop them on a Zip file in the active Explorer window, in another Explorer window,
or to a Zip file on the desktop. Note that you can create Zip files in the Explorer by selecting
New->WinZip File if you RIGHT-click in the Explorer.

e Another way to add files to a Zip directly from the Explorer: RIGHT-click on any file (or
selected group of files) in the Explorer and choose "Add To Zip" from the context menu.

Using the Desktop:

¢ If you select Add WinZip To Desktop in WinZip's Explorer Configuration dialog box, you can
drag one or more files to the WinZip icon on the desktop to add the files to an archive of your
choice.

¢ To create a Zip file on the desktop, right-click anywhere on the desktop and select "WinZip File"
from the New submenu.

Using the Start Menu:

e If you select Add WinZip to Start Menu in WinZip's Explorer Configuration dialog box, you can
start WinZip directly from the system Start Menu.

e You can open a recently accessed archive from the Documents submenu in the system Start
Menu.

Related Topics:

Hints and Tips

More Hints and Tips

Hints For Working With Downloaded Files
Frequently Asked Questions (FAQs)



Notes for Windows NT Users

The 32-bit version of WinZip works under Windows NT 4.0 as well as Windows 95, and includes long
filename and UNC support.

Notes:

The current versions of all optional external archivers used by WinZip are DOS programs and do
not support long filenames. Therefore, WinZip will pass the short 8.3 version of all long file and
folder names to these external programs. Since normal 8.3 names are usually more meaningful
than the shortened versions of long filenames, it is recommended you use standard 8.3 filenames
when working with external archivers.

Long Name Caution: DOS and 16-bit Windows programs usually have trouble with long
filenames and files with spaces in the name. Therefore, it is recommended that you do not use
long filenames and files with spaces in the name if you plan to work with these files from DOS.
For example, LHA.EXE will extract the file "A Long Filename" as "A LONG F", ignoring the extra
characters. To avoid this problem check the Store Filenames in 8.3 Format checkbox in the
Drop dialog box when adding files.

Some of the 16-bit Windows virus scanners listed in the Program Location dialog box do not work
or are not available under Windows NT.



Running WinZip under OS/2

Due to incompatibilities in the Windows 3.1 emulation of OS/2, some WinZip features do not work in this
environment. The built-in zipping and unzipping are fully functional, but operations which involve running

external programs are likely to fail.



Drag and Drop Interface

The Drag and Drop Interface provides a convenient way to:
1) Open an archive with WinZip
2) Add, freshen, move, and update files in an archive
3) Extract files from an archive
4) Use an archive in another application

For details click on the appropriate topic below. Additional drag and drop features are available under
Windows 95, as described in the section Windows 95 Features.

Related Topics:

Opening an Archive with the Drag and Drop Interface

Adding a File to an Archive with the Drag and Drop Interface
Extracting Files from an Archive with the Drag and Drop Interface
Dropping an Archive on Another Application

Drop Dialog Box

Add and Drop Dialog Box Options



Opening an Archive with the Drag and Drop Interface

To open an archive with the Drag and Drop Interface
1) Click on an archive in the Windows File Manager or Explorer.

2) While holding down the mouse button, move (drag) the mouse pointer over a WinZip window. If
you've minimized WinZip, you can drag the files to the minimized icon. If you're using the Norton
or Central Point Desktops, you can also drag files to inactive WinZip icons.

3) Release the mouse button. This opens the selected archive.

Note: you can also open archives by double clicking on the name of an archive in the File Manager or
Explorer, by clicking on the Open button in the main WinZip window, or by selecting Open from the file
pull-down menu.



Adding a File to an Archive with the Drag and Drop Interface

To add a file to an archive with the Drag and Drop Interface
1) Click on a file in the Windows File Manager or Explorer.

2) While holding down the mouse button, drag (move) the mouse pointer to a WinZip window. If
you've minimized WinZip, you can drag the files to the minimized icon. If you're using the Norton
or Central Point Desktops, you can also drag files to inactive WinZip icons.

3) Release the mouse button to drop the file. This activates the Drop dialog box. See the section
titted Add and Drop Dialog Box Options for a description of the options available in this dialog
box.

Notes:

To add multiple files to an archive using the Drag and Drop Interface, select the desired files in the File
Manager or Explorer before dragging them to WinZip.

You can also add files to an archive using the Add dialog box.

You cannot use the Drag and Drop Interface to add files with an extension of ZIP, LZH, ARJ, or ARC (use
the Add dialog box instead).

Under Windows 95 you can add files to a Zip without leaving the Explorer: just drag the files you want to
add to a Zip file anywhere in the Explorer.



Extracting Files from an Archive with the Drag and Drop
Interface

Note: The Windows 95 and Windows NT 4.0 implementation of this feature is more versatile than the
implementation under Windows 3.1.

Windows 95 and Windows NT 4.0:

You can drag and drop files from WinZip to other applications, to the Explorer, the desktop, to printers,
and to shortcuts. If you drop files on a folder in the Explorer, the files are extracted to that folder. If you
drop files on the desktop, the files are extracted to the desktop folder. If you drop files on another
application or on a shortcut, the files are extracted to the temp folder before the files are passed to the
application, and are removed when the archive is closed.

Windows 3.1:

You can drag and drop files from WinZip to other applications. WinZip will extract the files before
dropping them on the target application. The target application will treat the files as if they had been
dropped by the File Manager or Explorer.

The Windows File Manager will NOT accept files dropped by other applications. This is not a bug, it is
the result of a design decision made by Microsoft.

The Windows 3.1 Program Manager adds dropped files to the group on which the files are dropped. This
provides a very convenient way to add files in an archive to a Program Manager Group. Unfortunately,
many people would rather drop files on an icon in the Program Manager to start the program associated
with the icon, passing the dropped file as a parameter. However, there is nothing WinZip can do about
this. Again, this is not a bug, it is the result of a design decision made by Microsoft.

Important:

Different applications handle dropped files in different ways. For example, when you drop a file on the
Write application distributed as part of Windows it will embed the file as an OLE object, but when you drop
a file on the Notepad application distributed as part of Windows it will open the file. You may need to
experiment with drag and drop to understand how each application reacts to a file dropped on it.

Notes:

1. You can also extract files by pressing the Extract push button or using the Extract entry on the
Actions pull-down menu.

2. You can move or copy files from one archive to another by opening multiple copies of WinZip, one for
each archive, and dragging files from one to the other.



Dropping an Archive on Another Application

You can use the drag and drop interface to drop the open archive on another application as follows:
1) Click on the WinZip status line.

2) While holding down the mouse button, drag (move) the mouse pointer to a window that accepts
dropped files (the mouse pointer will indicate whether the target window accepts dropped files).

3) Release the mouse button to drop the open archive.
Examples of when this is useful include:
e Attaching an archive to a mail message when using a mail program like Microsoft Mail.

¢ Adding an archive to a disk image when using Winlmage, a shareware disk image utility available
on CompuServe and many BBSs.

Note: if no archive is open you cannot drag and drop from the WinZip status line.



Drop Dialog Box

The Drop dialog box is displayed when you use the Drag and Drop Interface to add files to an archive.
The Drop dialog box lets you change the name of the open archive in one of two ways:
1) Type the name of the archive in the Add to Archive edit field.

2) Click on the New... or Open... buttons to activate the standard New and Open dialog boxes,
respectively.

These shortcuts provide a quick way to add files to a different archive without going through the File pull-
down menu.

See the section titled Add and Drop Dialog Box Options for a description of the options available in this
dialog box.



Install/Try/Uninstall Feature

Windows 3.1 Only Note: a pre-release Windows 95 and NT 4.0 version of this feature is
available from the WinZip Home Page at www.winzip.com and from the "WinZip Beta" library (lib 22) of
the GO WINZIP area on CompuServe.

WinZip's unique Install/Try/Uninstall feature makes it easy to install and uninstall software distributed in
archives. This feature can save megabytes of disk space by tracking and removing all traces of an
application. WinZip will run the installation program in an archive, give you a chance to try the program,
and optionally offer to restore your system to its original state. The uninstall step can selectively remove
files, icons, or program groups created by an install program, and can restore any altered INI files. You
have complete control over the uninstall process, and no changes are made without approval.

Note: the Install feature is only available if an archive contains an "install" or "setup" program. If the
Install button is not displayed, use the CheckOut Feature to try the software in the archive.

To use the Install/Try/Uninstall feature

¢ Press the Install toolbar button or select Install from the Actions menu to extract all files to a
temporary folder and run the install program.

e Try the program that was installed.
¢ Decide whether to leave the program installed or to uninstall.
If you choose to uninstall WinZip will display the Uninstall dialog box which will let you select whether to
e Delete any Groups and Icons created by the installation process.
¢ Delete any Folders or files created by the installation process.

¢ Restore your autoexec.bat, config.sys, reg.dat, or ini files if they were changed by the installation
process.

Restrictions:

e All configuration changes made between an install and uninstall are considered to have been
made by the install process. For example, if you switch to your word processor and save a
document during the installation process, the document is considered to have been created as
part of the install process. If you subsequently uninstall, WinZip will list the document you
created in the Uninstall dialog box along with files created during the install procedure.
Therefore it is strongly suggested that you do not run any programs other than those related to
the program you are installing until you have decided whether to uninstall.

e The uninstall procedure does not let you restore files that are changed or deleted unless they are
one of the special files that are backed up during initialization: autoexec.bat, config.sys, reg.dat,
and the .ini files in your Windows folder.

Notes:
e The uninstall feature requires Windows 3.1 or Windows for Workgroups.

¢ The uninstall feature does not notice files or folders created from DOS boxes (after all, this is a
Windows program!).

¢ The uninstall feature does not attempt to save information across sessions.
e The Install operation requires that the entire product being installed is distributed in one archive.

e WinZip determines whether an archive contains an install or setup program by checking for a file
that 1) is executable, 2) has "install" or "setup" in the filename, and 3) does not contain folder
information. If no file matches these criteria the Install operation is disabled.

Related Topics:

uestions and Answers About Install/Try/Uninstall



Install Dialog Box
Uninstall Dialog Box



Questions and Answers About Install/Try/Uninstall

Windows 3.1 Only Note: a pre-release Windows 95 and NT 4.0 version of this feature is
available from the WinZip Home Page at www.winzip.com and from the "WinZip Beta" library (lib 22) of
the GO WINZIP area on CompuServe.

Here are answers to the three most frequently asked technical questions about WinZip's
Install/Try/Uninstall feature:

Question: Why shouldn't | run unrelated programs during an install?

Answer: All configuration changes made between an install and uninstall are considered to have been
made by the install process. For example, if you switch to your word processor and save a document
during the installation process, the document is considered to have been created as part of the install
process. If you subsequently uninstall, WinZip lists the document you created in the Uninstall dialog box
along with files created during the install procedure. Therefore it is strongly suggested that you do not
run any programs other than those related to the program you are installing until you have decided
whether to uninstall.

Question: What does WinZip do if a SETUP program replaces an existing DLL or VBX file?

Answer: WinZip's uninstall feature will never suggest you delete files that are used by other programs.
WinZip "watches" the setup process, and notices whether any existing files were replaced. If you later
choose to uninstall a program WinZip will list changes to pre-existing files in the Cautions dialog box, and
will not list them in the Uninstall dialog box, so these files cannot be accidentally deleted. Since no well-
behaved SETUP or INSTALL program will replace existing files with older versions of the same file, and
since all well-behaved DLLs and VBXs are designed so that new versions don't break programs relying
on old versions, there should be no negative effects on your system.

Note that WinZip does not backup all files on your system before running an install, so it is possible for an
ill-behaved SETUP or INSTALL program to "break" other applications. However, in no case will you be
worse off running WinZip with the Install/Try/Uninstall feature than if you run the SETUP or INSTALL
program without WinZip.

Question: Can | use WinZip to install a program, try the program for a week, and later use WinZip to
uninstall it?

Answer: No. WinZip's Install/Try/Uninstall feature was designed for the highest possible reliability. You
must decide whether to uninstall in the same session that you install. The advantage to this approach is
that WinZip has a very high uninstall success rate with a very easy to use interface. It is almost
impossible to guarantee a safe uninstall if you've had a chance to install other programs, make arbitrary
changes to your system configuration, etc. However, you can use the Report button in the WinZip
Uninstall dialog box to generate a disk file listing files that were changed, and use this file to manually
uninstall the program. In this case it is up to you to determine whether any programs you've since
installed depend on files that are part of the original install.



Install Dialog Box

The Install dialog box initially gives you two choices:

The Save Configuration Information for Possible Uninstall check box determines whether WinZip will
save information about your program groups, icons, and ini files. This information is required for an
uninstall operation, so if this checkbox is not selected you will not be able to use WinZip to uninstall.

The Minimize During Install checkbox determines whether WinZip will be minimized while running the
install program. If this checkbox is not selected you can activate WinZip after the installation by clicking
on the WinZip window, using the Task List, or using they Alt-Tab keys. If this checkbox is selected
WinZip will be minimized with the "always on top" attribute so that you can easily find it after you are done
running the installation program and trying the application that was installed.

Press the OK button to begin the installation. WinZip will then extract all files into a temporary folder,
optionally save system configuration information, and run the installation program.

After running the Install program the Install dialog box gives you two more choices:

Select the View Configuration Options for Possible Uninstall radio button to display the Uninstall
dialog box.

Select the No Uninstall Wanted radio button if you do not want to uninstall.
Press the OK button after you have made your selection.



Uninstall Dialog Box

Windows 3.1 Only Note: a pre-release Windows 95 and NT 4.0 version of this feature is

available from the WinZip Home Page at www.winzip.com and from the GO WINZIP area on
CompuServe.

The Uninstall dialog box displays a list box containing one entry for each item that can be uninstalled.
Entries are created for

e Groups and icons created by the installation process.
e Folders or files created by the installation process.
e Configuration files (e.g. win.ini) changed by the installation process.

Each entry contains a check box and a description of the action. Select or deselect the check boxes
depending on whether you want to uninstall the configuration change. Usually it is best to remove all
entries, however, this dialog box gives you a chance to avoid removing any files or icons you want to
keep.

The Select All button selects all check boxes.

If a Cautions... button is displayed in the Uninstall dialog box press it for information about system
configuration changes that the uninstall procedure cannot restore, for example, dynamic link libraries in
your Windows that have been replaced.

Press the Report... button to save a list of the suggested actions to a disk file.

Press the Uninstall button to begin the uninstall, or Cancel to terminate the operation. Additional
confirmation dialog boxes may be displayed depending on the specifics of the program being uninstalled.

Notes:

All actions in the Uninstall dialog box are automatically checked except file deletions. Individual files are
not selected for deletion in case you created files using some other application during the install process;
however, you can use the Select All button to quickly select all checkboxes in the list box.

If you decide to cancel the uninstall operation you may wish to create a report using the Report... button
to assist a manual uninstall.



File Manager Interface

WinZip's File Manager interface lets you open archives by double clicking in the File Manager, access
WinZip through a pull-down menu to the File Manager, and automatically start and stop WinZip along with
the File Manager.

You can also open archives by dragging them from the File Manager to a WinZip window, and can add
files to an archive by dragging them from the File Manager to a WinZip window as described in the
section Drag and Drop Interface.

Related Topics:

File Manager Configuration Dialog Box
The WinZip File Manager Menu

File Manager Add Dialog Box




File Manager Configuration Dialog Box

This dialog box is displayed when you select File Manager Configuration from WinZip's Options menu,
when you select Configuration from the File Manager's WinZip menu, and during WinZip installation.
The following choices are available:

The Associate WinZip With Archives checkbox determines whether you will be able to double
click on archives in the File Manager to open them. If this option is checked, the following
extensions will be associated with WinZip: ZIP, LZH, ARJ, ARC, TAR, TGZ, TAZ, GZ, Z, UU, UUE,
XXE, B64, HQX, and BHX. If this option is not checked, WinZip will ensure it is not associated
with these extensions. See the section titled Windows Associations for more information on
associations.

The Include WinZip In File Manager Menus checkbox determines whether the WinZip menu
entry is displayed on the File Manager menu bar.

The Start/Stop WinZip With File Manager checkbox determines whether the File Manager
automatically starts WinZip when the File Manager is started and closes WinZip when the File
Manager is closed. This ensures that WinZip is always available for drag and drop operations
from the File Manager.



The WinZip File Manager Menu

The optional WinZip menu in the File Manager provides the following choices:

The Open Archive entry will open the currently selected archive. If a WinZip task was started by
the File Manager that task will open the archive, otherwise a new WinZip task will be started to
open the archive.

The Add Files To Archive entry adds the selected files to an archive. If a WinZip task was
started by the File Manager that task will handle your Add request, otherwise a new WinZip task
will be started. In both cases you will have the opportunity to specify which archive should
receive the files you are adding.

The Configure entry activates the File Manager Configuration dialog box (described above).
The About entry displays a copyright notice.



File Manager Add Dialog Box

The File Manager Add dialog box is displayed when you use the Add Files To Archive entry in the File
Manager's WinZip pull-down menu. For information on enabling and disabling this menu entry see the

section titled File Manager Configuration Dialog Box.
This dialog box lets you change the name of the open archive in one of two ways:
1) Type the name of the archive in the Add to Archive edit field.

2) Click on the New... or Open... buttons to activate the standard New and Open dialog boxes,
respectively.

These shortcuts provide a quick way to add files to a different archive without going through the File pull-
down menu.

See the section titled Adding Files to an Archive for a description of the options available in this dialog
box.



Explorer Interface

Windows 95 and NT 4.0 Only You can zip and unzip files without leaving the Explorer,

as described in the section Windows 95 Quick Examples. You can also open archives by dragging them
from the Explorer to a WinZip window, and can add files to an archive by dragging them from the Explorer
to a WinZip window as described in the section Drag and Drop Interface.

Related Topics:
Explorer Configuration Dialog Box
Explorer Add Dialog Box



Explorer Configuration Dialog Box

Windows 95 and NT 4.0 Only This dialog box is displayed when you select Explorer
Configuration from WinZip's Options menu. The following choices are available:

The Associate WinZip With Archives checkbox determines whether you will be able to double
click on archives in the Explorer to open them. If this option is checked, the following extensions
will be associated with WinZip: ZIP, LZH, ARJ, ARC, TAR, TGZ, TAZ, GZ, Z, UU, UUE, XXE, B64,
HQX, and BHX. If this option is not checked, WinZip will ensure it is not associated with these
extensions. See the section titled Windows Associations for more information on associations.

The Explorer Shell Extension checkbox determines whether the WinZip Explorer context menus
are enabled, and whether you can use drag and drop to zip and unzip without leaving the
Explorer.

The Non-Cascaded WinZip Context Menu Items checkbox controls whether WinZip Explorer
context menu items are display in the main context menu or in a sub-menu.

The Display Icons on Context Menus checkbox determines whether a small WinZip icon is
displayed to the right of the WinZip Explorer context menu items.

If the Add WinZip to Start Menu checkbox is selected, WinZip is automatically added to the
Taskbar Start menu. Uncheck this option to remove WinZip from the Start menu.

If the Add WinZip to Desktop checkbox is selected, a shortcut to WinZip is added to the
desktop. Uncheck this option to remove the WinZip shortcut from the desktop.



Explorer Add Dialog Box

Windows 95 and NT 4.0 OnIy The Explorer Add dialog box is displayed when you use
the Add Files To Zip entry in the Explorer's context menu.

This dialog box lets you change the name of the open archive in one of two ways:
1) Type the name of the archive in the Add to Archive edit field.

2) Click on the New... or Open... buttons to activate the standard New and Open dialog boxes,
respectively.

These shortcuts provide a quick way to add files to a different archive without going through the File pull-
down menu.

See the section titled Adding Files to an Archive for a description of the options available in this dialog
box.



Favorite Zip Folders

The "Favorite Zip Folders" feature organizes downloads and all other Zip files into one convenient list that
is sorted by date, making it easier to locate all Zip files, regardless of where they came from or where they
are stored. For example: by default, CompuServe downloads go into the c:\cserve\download folder,
while AOL downloads go into the c:\aol\download folder. Unlike the standard File->Open Archive dialog
box, the Favorite Zip Folders dialog box treats the contents of multiple folders as though they were one
folder.

The first time you activate the Favorite Zip Folders dialog box, it will automatically search your computer
for folders containing or likely to contain Zip files. You can easily add and remove folders from your list of
"Favorite Zip Folders" using the Options button.

Click the "Favorites" button on the toolbar or select "Favorite Zip Folders" from the File pull-down menu to
activate this facility.



Menu Tree

File Menu
New Archive...

Open Archive...
Close Archive
Information...
Move Archive...
Copy Archive...
Rename Archive...
Delete Archive...
Exit

Actions Menu
Add...

Delete...
Extract...

View...

Select All
Deselect All
Virus Scan
Make EXE File
UUencode

Test
CheckOut...
Install...
Options Menu
Configuration...
Folders...

File Manager Configuration

Explorer Configuration
Font...

Password...

Program Locations...
Reuse WinZip Windows
Sort

Save Settings on Exit
Save Settings Now

Set Installation Defaults...

View Last Output...
Help Menu
Contents

Brief Tutorial

Hints and Tips
Search for Help on...
How to Use Help
Ordering Information

open a new archive

open an existing archive

close the open archive

display information about the open archive
move archive to a different drive or folder
copy archive to a different drive or folder
change file name of an archive

delete an archive

exit WinZip

add files to the open archive

delete files from the open archive

extract files from the open archive

view files in the open archive

select all files in an archive

deselect all files in an archive

run a virus scan program against archive contents
create a self-extracting archive

UUencode an archive

test integrity of an archive

examine and/or run programs in an archive
run "install" or "setup" program in archive

modify configuration options
specify default folders
configure WinZip File Manager interface

configure WinZip Explorer interface (Windows 95 and NT only)

specify font for main window

set password for subsequent archive operations
specify program names and paths

don't open new windows when WinZip is started
specify sort order for list of files in archive

control whether options are saved when WinZip is closed

save configuration settings immediately
set many options to original installation defaults

view output from the last command issued by WinZip

start Help and display topics in WinZip help file
display brief WinZip tutorial

display hints and tips

open search dialog box for WinZip help
display instructions for using help system
display order form



About WinZip... display copyright notice

The File Menu

The following entries are available on the file menu:

The New Archive menu entry creates new archives.
The Open Archive menu entry opens existing archives.

The Close Archive menu entry closes the currently open archive. This menu entry is included
primarily for completeness, since the New and Open menu entries automatically close the open
archive.

The Information menu entry displays a dialog box with the archive format, full filename, actual
archive size, number of files in the archive, average compression ratio, and the date and time that
the archive was last updated.

The Copy Archive, Move Archive, Rename Archive, and Delete Archive menu entries facilitate
Archive Management.

The Mail Archive menu entry, available only in configurations that include MAPI.DLL, makes it
easy to mail an archive to another user.

The Exit menu entry closes (terminates) WinZip.
The last four archives you opened can be re-opened directly from the File menu.



Creating a New Archive

To create a new archive, select New Archive from the WinZip File pull-down menu. This activates the
New Archive dialog box. Type the name of the archive you want to create. Do not enter the name of
the files you want to compress. This dialog box works almost like the standard Windows Open dialog
box. You can use the Drives and Folders list boxes to choose the drive and folder where the archive will
be created. For example, to create an archive on your floppy drive select A: from the Drives drop-down
list box. The names of any existing archives on the selected drive and folder will be listed in gray to help
you choose a name that is not already in use.

Check the Add Dialog check box in the New Archive dialog box if you would like to automatically activate
the Add dialog box after the new archive is opened.

To list self-extracting archives in the New and Open dialog boxes, select the "archives and exe files" entry
in the List Files of Type drop down list box. Note: When self-extracting archives are listed in the open
dialog box, all EXE and COM files in the selected folder will be listed, even if they are not self-extracting
archives. WinZip is not able to check whether a file is a self-extracting archive until it is opened.

Details on the File Type filters in the List Files of Type combo box are documented in the section File
Type Filters.



Opening an Existing Archive

To open an existing archive, select Open Archive from the WinZip File pull-down menu. This activates
the standard Open Archive dialog box. Then select the archive you want to open in the Open dialog
box. Opening an archive is just like opening a document in Write or a spreadsheet in Excel; the only
difference is that you open an archive instead of a document or spreadsheet. Use the Drives and
Folders list boxes to select the appropriate folder and click on the archive in the Archive Name list box.
Press the OK button when you have made your selection.

To list self-extracting archives in the New and Open dialog boxes, select the "archives and .exe files"
entry in the List Files of Type drop down list box. Note: When self-extracting archives are listed in the
open dialog box, all EXE and COM files in the selected folder will be listed, even if they are not self-
extracting archives. WinZip is not able to check whether a file is a self-extracting archive until it is
opened.

Details on the File Type filters in the List Files of Type combo box are documented in the section File
Type Filters.



Archive Management

The Copy Archive, Move Archive, Rename Archive, and Delete Archive entries in the File menu
facilitate archive management.

Copy Archive copies the open archive to another folder or disk. The Copy dialog box is displayed so
you can choose the destination for the copy operation.

Move Archive moves the open archive to another folder or disk. The Move dialog box is displayed so
you can choose the destination for the move operation.

Rename Archive gives you an opportunity to change the file name of the open archive. The Rename
dialog box lets you change the open archive's file name but not the filename extension (file type). Simply
type the new file name and press the OK button.

Delete Archive deletes the open archive. A confirmation dialog is displayed to avoid accidental deletion.
If you choose to continue the archive is closed and deleted.



Adding Files to an Archive

New users: For introductory information, please see the section Brief Tutorial - Adding Files to an Archive.

There are several ways to add files to an archive:
1) Use the Windows File Manager or Explorer Interface.

2) Click on the Add push button or select the Add entry from the Actions pull-down menu to bring up
the Add dialog box.

Using the Add dialog box:
¢  Windows 95: You can use the Add dialog box in two ways:
1) To add files from the Extended Selection List Box, first select files, then press the Add button.

2) To add files with wildcards (for example, *.c), type the filespec in the File name edit field, then
press the Add With Wildcards button. Standard wildcards are accepted, and multiple file
names can be specified.

¢  Windows 3.1 and Windows NT: You can use the Add dialog box in two ways:

1) Type the name(s) of the files you want to add in the Add Files edit field and press the Add
button. Standard MS-DOS wildcards (for example, *.c) are accepted, and multiple file names
can be specified.

2) Select files in the Select Files Extended Selection List Box and press the Add button. Use
the Update List button to update the list based on wildcards specified in the Add Files edit
field.

See the section titled Add and Drop Dialog Box Options for a description of the options available in this
dialog box.



Add and Drop Dialog Box Options

The Add and Drop dialog boxes include these options:

The Action drop down list provides four choices: Add, Freshen, Move, and Update. The Add
option causes WinZip to add all specified files to the archive. The Freshen option causes WinZip
to update files already in the archive that match the specified files. The Update option is the
same as Freshen, but adds any specified files that are not already in the archive. The Move
option works the same as Add, except that once the specified files have been successfully added
to the archive they are deleted from disk. These options correspond to the LHA and ARJ a, f, m
and u options when working with LZH and ARJ files, respectively.

The Compression drop down list determines the compression method. This field is disabled
when working with LZH files. Faster compression options usually result in larger archives.

The Multiple Disk Spanning drop down list controls how WinZip handles disk full conditions
while creating a new Zip file on removable media, such as a floppy disk. This drop down list is
disabled (not available) unless you are working with a new Zip files on removable media. When
this drop down list is available, you can select from one of three available values:

e Automatic will automatically prompt for another diskette when the diskette on which you are
creating a Zip file is full.

¢ Automatic + Wipe First Disk Prompt is the same as Automatic, but will give you the
opportunity to erase any files on the first diskette.

¢ No Spanning results in a "disk full" error message if the size of the Zip file exceeds the space
available on the removable diskette.

The Recurse Folders check box determines whether WinZip recursively traverses all folders
underneath the specified folder when looking for files to add. This provides an easy way to
backup all files underneath the folder containing the specified file. When working with LHA files,
this option corresponds to the LHA /r1x1 option. When working with ARJ files, this option
corresponds to the ARJ -r option.

Note: To restore a branch of a folder added with the Recurse Folders option, be sure to select
the Use Folder Names check box in the Extract dialog box.

The Save Extra Folder Info causes WinZip to store any folder path information specified in the
Add Files edit field. When working with ARJ files this check box prevents WinZip from
specifying the e option.

The Password button will password protect (encrypt) the file(s) you are adding. Please be sure
to read the information in the section titled Password Security before using passwords.

The Add With Wildcards button, available under Windows 95 and Windows NT 4.0 only, adds
the files specified in the File Name field. (In Windows "wildcards" are the asterisk and question
mark characters. These let you specify multiple files at once, for example, "*.Txt" refers to all
files with a file type of "Txt".)

The Store Filenames in DOS 8.3 Format checkbox, available under Windows 95 and Windows
NT 4.0 only, causes WinZip to store the short 8.3 MS-DOS compatible form of any long
filenames. "8.3" refers to the maximum of 8 characters in the filename portion of the name and 3
characters in the extension, for example, "12345678.123".

The Attributes section controls WinZip's handling of file attributes. Attributes are an advanced
subject; you do not need to understand attributes for normal WinZip operation. If you are
interested but not familiar with read-only, hidden, system, and archive attributes, please refer to
your Windows documentation. This section contains three options:

1) The Include Only If Archive Attribute Is Set option excludes files whose archive attribute is
not set.



2) The Reset Archive Attribute turns off a file's archive attribute after the file is added to the Zip
file.

3) The Include System and Hidden Files option causes WinZip to add files with the system
and hidden attributes. Normally files with these attributes are skipped.

Notes:

e If you use the Recurse Folders option and want to add files folders with the hidden or system
attributes set, you must select the Include System and Hidden Files option.

¢ The Include Only If Archive Attribute Is Set will exclude files whose archive attribute is not set.
This option does not control which folders are searched when the Recurse option is selected.



Deleting Files from an Archive

Select Delete from the Actions menu to activate the Delete dialog box. There are two ways to delete
files from an archive:

1) First select entries in the list box, then select the Delete entry from the Actions pull-down menu.
2) Select the Delete entry from the Actions pull-down menu to bring up the Delete dialog box. You

can then specify the file names you want to delete (standard MS-DOS wildcards like "*.txt" are
accepted). You can specify multiple file names, separated by spaces.

Note: these operations cannot be undone.

To delete an entire archive select the Delete entry from the Actions pull-down menu to bring up the Delete
dialog box. Then select the Entire Archive radio button and click on the Delete push button.
Alternatively, you can select Delete Archive from the File menu.



Extracting Files from an Archive
New users: For introductory information, please see the section Brief Tutorial - Extracting Files.

Use the Extract button on the toolbar or select Extract from the Actions menu to display the Extract
dialog box. Use the Extract dialog box to extract or "unzip" files from the open archive to your hard disk.

WinZip extracts files from the archive to the folder specified in the Extract To field. You can specify this
folder in one of four ways:

1.
2.
3.

4.

Select a folder and drive in the Folders/Drives list boxes.
Type a folder name in the Extract To field.

Pull down the Extract To combo box and select a folder from the list of previous Extract To
folders.

Press the New Folder... button and create a folder.

The Extract dialog box provides the following options:

Notes:

The Selected Files radio button instructs WinZip to extract only files that are selected in the main
WinZip window. See the section titled Using Extended Selection List Boxes for information on
selecting multiple files. This option is disabled if no files are selected.

The All Files radio button instructs WinZip to extract all files from the archive.

The Files radio button and edit field allow you to specify which files are extracted using filenames
or standard MS-DOS wildcards, for example, "*.XLS *.DOC" (don't type the quotes).

The Overwrite Existing Files check box determines whether you are prompted before existing
files are overwritten with files from the archive. It corresponds to the LHA /m1 option and the
ARJ -y option.

The Use Folder Names check box determines whether WinZip will use folder names (also known
as path names) stored in the archive. You will probably want to check this option for most extract
operations. If this option is checked any folder names stored in the archive will be appended to
the Extract To folder when appropriate. If this option is not checked all files will be extracted to
the same folder, regardless of any folder names in the archive.

For example, assuming the Extract To folder is "c:\temp", the file "mydir\filename" will be
extracted to the folder "c:\temp\mydir" if the Use Folder Names option is checked, or the folder
"c:\temp" if the option is not checked.

This option corresponds to the LHA x option and the ARJ x option.

The New Folder button activates the Create Folder dialog box. Note that you can extract files
and create a folder without this dialog box: simply type the name of the new folder in the Extract
To field of the Extract dialog box and press the Extract button.

You can also extract files using the Drag and Drop Interface as described in the section titled
Extracting Files from an Archive with the Drag and Drop Interface.
You can change the default Extract To folder using the Folders dialog box.




Viewing Files in an Archive

You can view files in an archive in several ways:

e With the View button in the toolbar or the View entry in the Actions pull-down menu. This
activates the View Dialog Box.

¢ With the features described in the section titled CheckOut Feature.

¢ Most files can be viewed by double clicking on the file name in the main window's list box, as
described in the section titled Double Clicking



View Dialog Box

When you push the View button in the toolbar or choose the View entry in the Actions menu the View
dialog box is displayed. This dialog gives you a choice of viewing the selected file(s) in one of three
ways:

1) Using the associated program. The associated program is listed in parenthesis. This method is
similar to double clicking on a file in the main window unless the file is executable; in that case
the file is opened with the program specified in the Default Association field in the Program
Locations dialog box.

2) Using the built-in internal ASCII text viewer. Multiple files can be viewed in one view operation
using this viewer.

3) With any viewer available on your system. You must specify the name of the viewer.



Built-In Viewer

The built-in ASCII text viewer can be used to view files in an archive, and is used to view the results of the
last operation using the View Last Output entry in the Options pull-down menu.

Unlike most dialog boxes, the viewer window can be resized and maximized.

Click on the Clipboard Copy push button to copy selected text to the system clipboard. If no text is
selected all the text is copied to the clipboard.

Notes:

e Due to limitations in the standard Windows multi-line edit control, under Windows 3.1 the built-in
text viewer only displays the first 32K of a file. However, you can view larger files by double
clicking on files in the main WinZip window or by using the CheckOut facility.

e The viewer is limited to plain ASCII text, just like the Windows Notepad application.



Select All and Deselect All

The Select All and Deselect All menu entries in the Actions menu select and deselect all files in the main
window's list box. Selected files can then be easily deleted, extracted, or viewed.



Virus Scan

Use the Virus Scan entry in the Actions pull-down menu to determine whether files in the archive contain
viruses. To use this feature a virus scanner must be configured, as described in the section titled Virus
Scanner Configuration. Note that the CheckOut feature also provides optional virus scanning.

The Virus Scan operation performs the following actions:

1)
2)
3)
4)
5)

Creates a temporary folder

Extracts all files in the current Zip to the temporary folder

Runs the virus scanner against files in the temporary folder

Deletes all files in the temporary folder and removes the temporary folder
Displays the results of the scan operation in the View window



Creating a Self-Extracting Archive

Use the Make .EXE File entry in the Actions menu to convert the open archive to a self-extracting
archive. Self-extracting archives have an extension of .EXE, and can be run as commands. When a
self-extracting archive is run, the files in the archive are automatically extracted. This is convenient,
because the end user does not need an unzip program (like WinZip) to extract files from these self-
extracting archives.

When working with a Zip file, this operation normally runs WinZip Self-Extractor Personal Edition, but you
can also configure WinZip to use another program. When working with an LZH file, this operation runs
the external LHA program with the s option. When working with an ARJ file, this operation runs the
external ARJ program with the y option. For details on configuring WinZip to work with external

programs, see the sections titled System Requirements and Installing Optional External Programs.
Notes:

e If the first file in a self-extracting LZH file is named "!" (i.e. an exclamation mark is the only
character in the filename) this file will be displayed when the self-extracting executable is run. To
ensure that this file is the first file in the archive create a new LZH file, then add the "!" file (do not
add other files in this step), and finally add the remaining files.

e When using ZIP2EXE, be sure to use ZIP2EXE version 2.0 or later , otherwise you will get the
message "don't know how to handle file" when running the self-extracting archive.

e Please be sure to read the ZIP2EXE license agreement before distributing files created with
ZIP2EXE.



UUencoding an Archive

Use the UUencode entry in the Actions pull-down menu to UUencode the open archive. The
UUencoded file can be sent across mail systems that do not support binary e-mail. For further details on
UUencoded, XXencoded, BinHex, and MIME files, refer to that section of this help file.




Testing an Archive

Use the Test entry in the Actions pull-down menu to test the integrity of the open archive. A dialog box is
displayed with the results of the test operation. This command does not require an external program
when working with Zip files. This command runs LHA t for LZH files, and ARJ t for ARJ files.

Press the Esc key during the Test operation to terminate the integrity test.



CheckOut Feature

The CheckOut feature makes it easy to examine and/or run files in an archive. It creates a program
group containing one icon for each file in the archive. Double click on the icon in the program group to
run the file or to view the file using the program that is associated with the file (associations are described
in the section titled Windows Associations). WinZip will optionally delete the program group and related
files when you close the archive or close WinZip.

Windows 95 users can access program groups from the Start menu. Windows 3.1 and Windows NT
users can access program groups from the Program Manager.

CheckOut Dialog Box

Use the CheckOut toolbar button or the CheckOut entry in the Actions pull-down menu to activate the
CheckOut dialog box. This dialog box lets you configure these aspects of the operation:

e Use the Folder edit field to specify the temporary CheckOut folder name. The folder will be
created if it does not already exist. The suggested folder depends on the setting of the
CheckOut Base Folder in the Folders dialog box.

e Use the Group Name edit field to specify the name to use for the program group.

¢ Use the Ilcon Maximum for CheckOut Group edit field to specify the maximum number of icons
for the CheckOut program group. The Windows 3.1 Program Manager limits you to 50 entries,
but you may prefer a lower number to save time.

¢ The Run Virus Scanner check box lets you specify whether WinZip will run a virus scanner on
the files in the archive. This option is disabled unless a virus scan utility is installed in the
Program Locations dialog box.

e The Create Icons For Programs And Documents Only check box lets you control whether
WinZip creates icons for all files in the archive or only for the specified files. When this option is
selected, icons are created for executable files and files with associations. Icons are also
created for any files with names starting with "read" (in order to catch files with names like
"readme.1st", "read.me", etc.).

Operations performed by the CheckOut feature:
When you click on the OK button in the CheckOut dialog box, WinZip performs the following operations:

1) If the specified folder already exists and contains files WinZip will delete the files if you give it
permission. Otherwise the folder is created. This ensures that the folder will contain only files
from the current archive.

2) If the specified program group already exists, WinZip will delete the group if you give it
permission. This ensures that the group will contain only icons for files in the current archive.

3) WinZip extracts files in the current archive to the specified folder.

4) If the Run Virus Scanner check box is selected your virus scanner is run against all files in the
specified folder. If the virus scan utility returns a non-zero error level, the CheckOut operation is
aborted and messages from the scanner are displayed.

5) WinZip creates a new program group containing the appropriate icons.
Using the program group created by CheckOut:

The program group created by CheckOut works like all other program groups. WinZip creates icons in
this group for each file so that you can use them as follows:

e If afile is executable, double clicking on the icon runs the program.

e [f afile has an association, double clicking on the icon loads the file in the associated program so
you can view the file.

e Otherwise, double clicking on the icon loads the file in the WinZip Default Association program
specified in the Program Locations dialog box.






Options

Use the Configuration entry in the Options pull-down menu to activate the Configuration dialog box.
This dialog box lets you specify miscellaneous WinZip configuration information, including the default
archive format and options controlling the appearance of WinZip windows.

Use the Folders entry in the Options pull-down menu to activate the Folders dialog box. This dialog box
lets you specify the initial WinZip working folder, the default Extract folder, and an optional temporary
folder for use while creating archives.

Use the Font entry in the Options pull-down menu to activate the Font dialog box. This standard dialog
box lets you specify which font is used for the list of files in an archive.

Use the Password entry in the Options pull-down menu to activate the Password dialog box. This dialog
box lets you set a password for the open archive.

Use the Program Locations entry in the Options pull-down menu to activate the Program Locations
dialog box. This dialog box lets you specify the location of external programs, such as a virus scanner or
default file viewer.

The Sort by entries in the Options pull-down menu let you specify whether the list of files in the archive is
sorted by name, path, type, size, compression ratio, compressed size, date, or whether the original
archive order should be used. Note: You can also change the sort order by clicking on the appropriate
portion of the main list box header. For example, click on the word "Date" in the header to sort by date.

The Reuse WinZip Windows entry in the Options pull-down menu determines whether a new window is
opened when you start WinZip by double-clicking in the File Manager, Explorer, or Program Manager.
When this entry is checked, an existing WinZip window is used. When this entry is not checked, a new
WinZip window is created. One advantage to reusing WinZip windows is that double clicking acts the
same as drag and drop, and you never accidentally wind up with multiple WinZip windows.

The Save Settings on Exit entry in the Options pull-down menu determines whether options are
automatically saved when WinZip is closed.

The Save Settings Now entry in the Options pull-down menu saves the options immediately. Options
that are saved and restored include all the options in the Options pull-down menu, all options in the Add,
Configuration, and Extract dialog boxes, and the current screen size and location. The options in the
Folders Dialog Box and the Program Locations Dialog Box are saved regardless of whether Save
Settings on Exit is checked.

The Set Installation Defaults entry in the Options pull-down menu sets many configuration options and
folder names to the original installation defaults.

Use the View Last Output entry in the Options pull-down menu to display the results of the last
command issued by WinZip.



Configuration Dialog Box

Select Configuration from the Options menu to activate the Configuration dialog box. This dialog box
lets you specify

¢ Whether the normal prompt dialog boxes are displayed in the following circumstances:

1. When a file is dropped on WinZip. If no prompt is displayed, the file is automatically added
to the open archive using the options last specified in the Drop dialog box. Note that when
an archive is dropped on WinZip the archive is opened regardless of this setting.

2. When afile is dragged from WinZip to another application. If no prompt is displayed, the file
is automatically extracted using the options last specified in the Extract dialog box.

3. When the View button is pushed. The selected file(s) are automatically viewed. Note that
when View is selected from the Actions pull-down menu this setting is ignored.

4. When the Extract button is pushed. The selected file(s) are automatically extracted using
the options last specified in the Extract dialog box. Note that when Extract is selected from
the Actions pull-down menu this setting is ignored.

Note: you can toggle these settings by holding down the shift key. For example, if the Prompt
When Extract Button Is Pushed option is checked, you can bypass the Extract dialog box by
holding down the shift key while pressing the Extract button.

e The Default Archive Format. This format is used when you specify the name of an archive
without an extension while creating or opening an archive, and when creating an archive with an
extension other than .ZIP, .LZH, or .ARJ.

e Whether WinZip should automatically show the Open Archive dialog box when you start WinZip.

e Whether WinZip should beep after archive operations that take more than one second to
complete.

¢ Whether the background on the header is displayed in light or dark gray.

e Whether "Smart DOC Handling" is enabled. This feature is described in the section titled Double

¢ Whether the right mouse button displays a pop-up menu or is used to select files in the main
WinZip window.

e Under Windows 95 and Windows NT 4.0, you can control whether the Extract dialog box contains
a tree view control or the Windows 3.1 style folder control.

e Under Windows 3.1 you can control whether WinZip should display 3D dialog box borders instead
of the normal dialog box borders.

e Whether WinZip should maintain a log of all error messages and all external commands it issues.
Examples of external commands are LHA and ARJ. You can specify the drive used for the log
file. The log is written to the file WINZIP.LOG in the root folder of the selected drive.

e Whether WinZip should list the files in the archive in lowercase for improved legibility (under
Windows 3.1) or should list uppercase filenames in lowercase (under Windows 95 or Windows
NT).

¢ Whether WinZip should have the "always on top" attribute, so that it is not overlaid by normal
windows.

e Whether "smart" CR/LF conversion should be performed when extracting from TAR files. CR/LF
is short for Carriage Return/Line Feed, the standard end of line indicator. This option can be
useful when a TAR file contains text files created on a Unix or Macintosh machine. Unix text files
usually contain lines ending in Line Feed characters only, and Macintosh text files usually contain
lines ending in a Carriage Return character. The standard Windows Notepad program and many
other Windows programs require a Carriage Return and Line Feed at the end of each line.

When the TAR File Smart CR/LF Conversion option is in effect, WinZip determines whether to



perform CR/LF conversion for each file inside a TAR file by looking at the first 80 characters in
each file. If the file is a text file then single LF and CR characters are converted to CR/LF pairs
so the file can be viewed by Notepad and other Windows viewers. Files are considered text
when the first 80 bytes contain only characters with ASCII values between 0x20 and 0x7f,
carriage returns, line feeds, form feeds, tabs, and other alphanumeric characters (as determined
by the Windows IsCharAlphaNumeric API).

Whether compressed file sizes and the compression ratio should be displayed in the main WinZip
listbox.

Whether icons are shown next to each entry in the main listbox to indicate whether a file is
executable or has an association.

Whether WinZip should use the Wizard interface next time it is started.
Whether WinZip displays large toolbar buttons.

Whether WinZip uses high color toolbar buttons on systems capable of displaying them. This
option is only available when using large toolbar buttons.



Folders

Select Folders from the Options menu to display the Folders dialog box. This dialog box lets you specify
the following information:

Start-up Folder

Unless you start WinZip by double clicking on an archive, WinZip will optionally change to a folder of your
choice when it starts up. Files in this folder are automatically displayed in the Open Archive and New
Archive dialog boxes. The following choices control which folder is used.

e System default - WinZip does not change folders, so the system default folder is in effect.
Usually this is the folder containing WINZIP.EXE or WINZIP32.EXE.

e Last Open Archive - WinZip changes to the folder containing the last open archive during your
last WinZip session, unless it is on your A: or B: drive.

e Folder: - WinZip always changes to the specified folder.
Default Extract Folder

These selections determine the default folder that WinZip automatically lists in the Extract To field in the
Extract dialog box. You can, of course, type over this default folder name or select a different folder from
the folder listbox.

¢ Open Archive Folder - WinZip lists the name of the folder containing the open archive in the
Extract To field. For example, if the archive c:\download\tools.zip is open, WinZip will list c:\
download.

e Last Extract Folder - WinZip will list the name of the folder you used during the last Extract
operation, unless it is on your A: or B: drive. This value is saved when you exit WinZip so you
can use it during your next WinZip session.

¢ Folder - WinZip always lists the specified folder. This value is saved when you exit WinZip so
you can use it during your next WinZip session.

Default Add Folder
These selections determine the default folder when the Add dialog box is opened.
e Open Archive Folder - WinZip uses the folder containing the open archive.

e Last Add Folder - WinZip uses the folder you used during the last Add operation, unless it is on
your A: or B: drive. This value is saved when you exit WinZip so you can use it during your next
WinZip session.

¢ Folder - WinZip always uses the specified folder. This value is saved when you exit WinZip so
you can use it during your next WinZip session.

Optional Working Folder

If specified, temporary Zip files are created in this folder. If this option is not specified, temporary Zip files
are created in the folder containing the open Zip file. This option is particularly useful when you are
updating an archive and there is not enough room on the destination drive for both the original archive
and the updated archive. This is most likely to occur when you are working with removable media (e.g.
floppy disks). You can tell WinZip to use this feature only when working with Zip files on removable
media by checking the Use for Removable Media Only checkbox.

When using ARJ to create an archive WinZip specifies this folder name via the -w switch.
CheckOut Base Folder

If specified, WinZip uses this folder as the prefix for the default folder in the CheckOut dialog box. If this
field is left blank WinZip will instead use the folder containing the open archive.

Temp Folder
This entry specifies the location for temporary files created by WinZip, including files created during the



View and Virus Scan operations. If you run out of disk space during a View or Scan operation, change
the Temp Folder to specify a drive and folder with sufficient free space.



Password Security

WinZip uses the industry standard Zip 2.0 encryption format. Password protecting files in a Zip provides
a measure of protection against casual users who don't have the password and are trying to determine
the contents of your files. The Zip 2.0 encryption format, however, is not as secure as DES and the RSA
public key formats used by programs such as PGP, and does not provide absolute protection against
determined individuals with advanced cryptographic tools.

Note: there are two reasons WinZip does not implement a more secure encryption format: (1) a
different format would not be compatible with the Zip 2.0 standard, so other Zip utilities would not be able
to decrypt the files, and (2) there are currently severe U.S. government restrictions on the export of
encryption technology. If you require strong encryption, we recommend you use a specialized encryption
software instead of the Zip 2.0 encryption format.

The main WinZip window lists password protected files with a plus sign following the filename.
Using password security while using the Extract, Test, CheckOut, or Install features:

If you use the Extract, Test, CheckOut, or Install features on a password protected archive, you will
automatically be prompted for the password.

Using password security while adding or updating an archive:

To password protect files, it is important to specify the password AFTER opening or creating an archive
and BEFORE adding the files.

Follow these steps to password protect files in an archive:

1. Open or create an archive. If you are using the New dialog box uncheck the Add Dialog
checkbox at the right of the dialog box.

2. In the Add or Drop dialog box, click the Password button, and type a password.
Notes:

¢ In addition to the methods specified above, you can select Password from the Options button to
specify a password.

¢ Use the Mask Password checkbox to control whether the password is hidden while typed. If you
check this option, you will have to re-type the password for confirmation (to avoid typographical
errors).

e Passwords are cleared (reset so that no password is in effect) when an archive is closed or another
archive is opened.

e Passwords can also be used for ARJ files; in this case, the external ARJ program is responsible for all
data encryption.

e Be sure to remember any passwords you use, so that you can Extract your files!



Program Locations

Select Program Locations from the Options menu to activate the Program Locations dialog box. This
dialog box lets you specify the paths and filenames for the optional external programs supported by
WinZip. Note that these programs are not required for most operations involving Zip files.

If you are installing WinZip and are not familiar with these programs you can just press the OK button to
continue the installation procedure.

External programs are not distributed with WinZip. For more information on these programs, including
availability and minimum version numbers, see the section titled System Requirements. For step by step
installation examples for external archivers see the section titled Installing Optional External Programs.
See the section titled Virus Scanner Configuration for information about that portion of the dialog box.

If a program is not installed on your system, just leave the corresponding edit field blank. Otherwise, fill
in the program name. The extension defaults to EXE. If no path is included for an entry, WinZip
assumes that the program is in a folder specified in your PATH= environment variable.

Example:
The entry for the Optional Virus Scanner could have any of these values:
Value Description

If the entry is blank, WinZip assumes that no virus scanner is installed
on your system.

SCANNER.EXE Just the filename is needed if the specified file (SCANNER.EXE, in
this example) is in a folder specified in your PATH= environment
variable.

C:\SCANNER\SCANNER.EXE The full drive, folder, and filename are required if the specified file

(SCANNER.EXE, in this example) is not in a folder specified in your
PATH= environment variable. Note that CASCANNER is just an
example, any other folder can be used.

Notes:

When WinZip is installed it will attempt to locate the default programs for each field in the folders specified
in your PATH= environment variable. If it cannot find these programs, it will leave the corresponding edit
fields blank.

The program specified as the Default Association is used when viewing a file that does not have an
association. For additional information on associations, see the section titled Windows Associations.
The defaults for this field are:

e QuickView (quikview.exe), if you are running Windows 95 or Windows NT 4.0 and have installed
this optional component.

e SCCVAPILEXE, System Compatibility Corporation's "Outside In" file viewer, if it is found in a folder
specified by your PATH= environment variable.

¢ NVIEWER.EXE, the Norton Desktop for Windows File Viewer, if it is found in a folder specified by
your PATH= environment variable.

e  WNFV.EXE, the PC Tools for Windows File Viewer, if it is found in a folder specified by your
PATH= environment variable.

¢ NOTEPAD.EXE, the Windows Notepad program, if NVIEWER and WNFV are not found.
Almost any other file viewer or editor can be used.



Virus Scanner Configuration

WinZip supports many virus scanners that can be run from Windows or from the DOS command line, with
a few important limitations noted below. Virus scanners can be run using the Scan entry in the Actions
menu or during CheckOut operations if the Run Virus Scanner option in the CheckOut dialog box is
selected.

Virus scanner configuration is done from the Program Locations dialog box. Select Program Locations
from the Options menu to activate this dialog box.

When you first install WinZip, it automatically searches for the following virus scanners in the folders
specified by your PATH= environment variable, and, under Windows 95 and NT, in the "App Paths"
registry entries. If one of these virus scanners is found, WinZip will automatically fill in the Program
Locations dialog box with the appropriate parameters.

Scanner Parameters
SCAN95.EXE *.* lautoscan /nosplash
SCAN32.EXE %d /autoscan /nosplash
NAVW32.EXE ** s

NAVW.EXE /auto *.* /S
WNAPVIR.EXE /QM/M-/B- *.*

NAV.EXE **Im-/s

CPAV.EXE **IP

MSAV.EXE **IP

WSCAN Y%wscan

SCAN.EXE /nomem *.* /ALL /SUB
WFINDVIR %d

TBSCAN ** %d In=%f lo nb nm
F-PROT /INOBOOT /NOMEM /LIST *.* IREPORT=%f

If the installation procedure does not automatically find one of the aforementioned virus scanners, you
can have WinZip automatically fill in the Parameters field by selecting the desired scanner from the drop-
down combo box (for example, scan.exe) and then adding the full filename for the scanner to the
Scanner field (for example, c:\mcafee\scan.exe instead of just scan.exe).

You can also configure WinZip to work with another scanner. See the section titled Virus Scanner
Configuration Details below for more information.

Notes:

The default parameters in the table above work with the versions of the scanners that were tested. If the
authors of a scanner change the command line parameters in future releases of the scanner, then
WinZip's default parameters for the scanner may no longer work. For example, McAfee SCAN 2.1
parameters are incompatible with prior versions of SCAN. Version 2 requires the /ALL parameter while
version 1 requires /A.

Unless a virus is found, no manual intervention is required while running most virus scanners. However,
the WSCAN and TFINDVIR scanners always need to be closed manually, because they do not currently
support options to close automatically.

Virus Scanner Configuration Details

This portion of the documentation describes how to configure WinZip to work with a scanner that is not
listed above. Do not use WinZip's virus scanning support with a different virus scanner unless you have
read and understood the following information.

To configure WinZip to work with a scanner, fill in the following fields in the Program Locations dialog box:

1) The Scan Program field should contain the name of the program (the full path name is required if
the program is not in a folder specified in your PATH= environment variable).



2) The Parameters field should contain the appropriate parameters to run the virus scanner as
described below.

3) The Run Minimized box determines whether the scanner should be run as an icon. See below
for important notes on using this parameter with DOS based scanners. Note that the
NAVW32.EXE scanner always runs minimized, regardless how you set this option.

Special character sequences for the Parameters field are:

*x indicates where WinZip should substitute the drive, folder, and the *.* characters for the files
that are to be scanned. For example, "c:\temp\dir\*.*".

%d indicates where WinZip should substitute the drive and folder of the files that are to be
scanned. Note that the wild card characters *.* are NOT included when you use %d.

Yof indicates where WinZip should substitute the name of a temporary "report file". Report files

should ONLY be used when running DOS virus scanners.
Y%wscan a special parameter required for McAfee's WSCAN program.

If you do not specify any of the aforementioned special character sequences WinZip will append the
filenames to be scanned at the end of the scanner command line.

Be sure to specify any parameters necessary to cause the scanner to check folders of the drive and folder
of the files that are to be scanned.

To configure WinZip for a Windows based virus scanner, first ascertain that the virus scanner reports
suspected viruses by displaying a dialog box. If the scanner simply writes to a log file when a virus is
found you (and WinZip) will not know about the problem.

To configure WinZip fora DOS based virus scanner, be sure to verify that the scanner can either be
used with the Run Minimized option (see below for details) or issues a prompt if a virus is found. If
neither of these conditions is met and a virus is found you (and WinZip) will not know about the problem.

The Run Minimized check box should only be used for DOS scanners under the following
circumstances:

1) The scanner is configured to run in "batch" mode, without any prompts. If the scanner requires
any keyboard input when running as an icon, you will not be able to see the prompts, and the
session will appear to be hung.

2) The scanner writes all messages through DOS, or has an option to write results to a report file.
Messages written directly to the video buffer are not captured by WinZip and will be lost. To
determine whether a scanner writes messages through DOS, run the scanner with its output
redirected (for example, issue the command "scan > nul"). Any messages you see during this
test will not be captured by WinZip. If the scanner has an option to write results to a report file
you can use %f in the Parameters field to cause WinZip to capture the results (see above for
details).

3) The scanner returns a non-zero error level if it encounters any problems. If the scanner does not
return a non-zero error level, WinZip will assume that the files passed the virus check, and any
warnings issued by the scanner will be lost. (Note: if the scanner returns a non-zero error level,
WinZip automatically displays all messages written to standard error or standard output.)



Create Folder

This dialog box lets you create a folder. This folder becomes a sub-folder of the current folder unless you
specify a path.

Note: you can only create folders in existing folders; you cannot create multiple folders at once. For
example, if the following folder is empty

C:\Test Folder

You can create the folder
C:\Test Folder\One Level Is Ok

But cannot create the following two folders at once:
C:\Test Folder\Level One Folder\Level Two Folder



Double Clicking

Double clicking on a filename listed in the main WinZip window will perform the same action performed
when you double click on a file in the File Manager or Explorer. If the file is executable (has a filename
extension of EXE, COM, BAT, or PIF) WinZip will run it. Otherwise WinZip will open the file with the
appropriate application. For example, files with a filename extension of .\WRI are opened by the
Windows Write application. The appropriate application is determined via Windows Associations. If no
application is associated with the file, WinZip will run the program specified as the Default Association in
the Program Locations dialog box. If you modify the file while viewing it, WinZip will offer to add the
modified file to the archive.

If the Smart DOC Handling option in the Configuration dialog box is enabled and you double click on a
file with a file type of .DOC, WinZip will run one of two programs:

1) If the .DOC file looks like plain ASCII text WinZip will run the program specified as the Default
Association in the Program Locations dialog box.

2) If the .DOC file looks like a file created by a word processor WinZip will run the program
associated with .DOC files.

Smart Doc Handling avoids the overhead of loading a word processor like Word for Windows when
viewing ASCII text files like "readme.doc".

Note: Pressing the Enter key performs the same action as double clicking.



Windows Associations

Microsoft has defined the word "associate" as follows:

To identify a filename extension as belonging to a certain application, so that when you open any file with
that extension, the correct application is opened automatically.

For example, by default, Windows associates .WRI files with the Write or WordPad application, and .CRD
files with the CARDFILE application. Most Windows application installation procedures create
associations. For example, Word for Windows creates an association for .DOC files, while WinZip
creates associations for files with the extensions ZIP, LZH, ARJ, ARC, TAR, TGZ, TAZ, GZ, Z, UU, UUE,
XXE, B64, HQX, and BHX.

WinZip uses associations when you Double Click on a filename listed in the main WinZip window and
when you use the CheckOut Feature.

WinZip, the Explorer, the Program Manager, and the File Manager all use associations the same way.
When you double click on a file with an association, the application associated with the file is run, and the
application automatically opens the file. The WinZip CheckOut facility establishes associations when it
updates the CheckOut program group for two reasons: to display the right icon for each file, and to ensure
that the appropriate application is run when you double click on an icon.

Under Windows 95 you can view, add, and remove associations using the File Types tab in the Options
dialog box in My Computer or the Explorer. Select Options from the View pull-down menu in My
Computer or the Explorer, then click the File Types tab. Press the F1 key for detailed instructions.

Under Windows 3.1 and Windows NT you can view or add associations using the Associate entry in the
File Manager's File pull-down menu as follows: start the File Manager and select a filename with the
extension you are interested in. Then choose the Associate entry in the File Manager's File pull-down
menu. Press the F1 key for details.



Using Extended Selection List Boxes

WinZip uses Extended Selection List Boxes for the list of files in the open archive and for the list of files in
the Add dialog box. You can select files from an Extended Selection List Box in the same way that you
select files in the File Manager or Explorer.

To select an individual file in an Extended Selection List Box, click on the file. This cancels all previous
selections. To select two or more files in sequence, click on the first file, then press and hold down the
Shift key while you click on the last file in the group. To select two or more items out of sequence, press
and hold down the Ctrl key while you click on each file.

In addition to the aforementioned standard methods for working with Extended Selection List Boxes, you
can use the right mouse button to select files without canceling previous selections. This feature was
added for compatibility with Norton Desktop for Windows.

You can use the Select All and Deselect All entries in the Actions pull-down menu to select and deselect
all files in an archive.

The keyboard interface for Extended Selection List Boxes is described in the section titled Keyboard
Usage.



Multiple Disk Spanning
WinZip makes it easy to create Zip files that "span" multiple disks. This is useful if the files you are
working with will not fit on one disk.

To make a Zip file that spans multiple disks, simply create a Zip file on a removable disk, then add files to
the Zip as you normally would. If the disk fills during Add operation, you will be prompted for another
disk. Simply insert the next disk and click the OK button.

Important: disk spanning is not available when adding files to an existing archive; it is only available
while creating a new archive. Also note that you cannot add or remove files from a Zip file that spans
disks. WinZip requires pre-formatted disks (you can format disks using the Windows Explorer or File
Manager)

Example:
To zip the files in your c:\data folder to a Zip file called A:\DATA.ZIP:
1) Start WinZip
2) Drag and drop the c:\data folder from the Explorer or File Manager to the WinZip window
3) In the Drop dialog box, type the filename of the Zip file (A:\\DATA.ZIP)
4) Click the Add button
If more than one disk is needed, you will be prompted for additional disks.



Enhanced and Standard Modes

Windows 3.1 Only In Windows 386 Enhanced mode LHA, ARJ, and other external programs
run by WinZip are executed in the background in an iconized DOS session. While these commands are
running you can switch to another window using the Task Manager or by clicking on the desired window.
An hourglass pointer is used to indicate that the WinZip window is busy. You can double click on the icon
titled "WinZip running DOS commands" to monitor the command's progress. If any of these commands
prompts the user for input, WinZip will automatically bring the DOS session to the foreground.

Unfortunately, Windows does not allow you to execute these commands in the background under
Standard mode. In Standard mode your screen will be cleared, and these commands will be run in a full
screen DOS session.

In all cases you can view the messages displayed by the last command issued by WinZip by
selecting View Last Output in the Options pull-down menu.

Your Windows User's Guide contains descriptions of Enhanced and Standard modes. You can
determine which mode is active by choosing the About entry in the Program Manager's Help pull-down
menu.



Norton Desktop For Windows
Windows 3.1 Only

NDW 3.0 Notes:

You can open archives with WinZip by double clicking in the NDW Drive Window if you turn off
the Show Zips As Folders entry in the Drive Window's Tree menu. Be sure to save your NDW
settings after making this change.

If you installed NAVW (Norton Anti-Virus for Windows) as your WinZip virus scanner while running
NDW 2.0, you will have to change the Virus Scanner Parameters in WinZip's Program Locations
dialog box. Simply remove the /auto portion of the parameters. This switch is still required for
earlier versions of NAVW.

The initial release of the German version of NDW 3.0 has a bug that prevents the CheckOut and
Install options from creating program groups. Symantec is working on a fix.

The features described in the section titled File Manager Interface all work with Norton Desktop
drive windows. Note: if you have added the MaxWinFileExtensions=0 line to your NDW.INI, the
WinZip menu will not be displayed in NDW drive windows. In this case you'll have to increase
the value of this configuration option to see the WinZip menu.

NDW 2.0 Notes:

Several Norton Desktop 2.x users have reported that the WinZip CheckOut feature sometimes
places icons into the wrong group. This is apparently caused by a bug in NDW 2.x. This
problem is easy to fix: select Quick Access from the NDW Window pull-down menu to display all
groups. Delete any duplicate groups, or groups that should not be listed (e.g. groups for
products that have been uninstalled). Then select Save Configuration from the NDW
Configuration pull-down menu. At this point the problem should not re-occur.



Norton Navigator for Windows 95
Windows 95 Only

Restoring the association for Zip files after installing Norton Navigator:

Norton Navigator SETUP associates Zip files with Norton Navigator. If you subsequently run WinZip it
will offer to re-associate itself with Zip files. If you choose "Yes" you can use WinZip exactly as you did
before installing Norton Navigator. Note: it is possible the icons for Zip files will not change until you re-
boot Windows 95.

Using WinZip with Norton File Manager:

You can start WinZip by double clicking on Zip files in Norton File Manager after following these steps:
(1) select General from the Norton File Manager Options menu, (2) in the Advanced tab uncheck the
"Show compression files as Directories" checkbox, and (3) press OK.

Restrictions:

The Norton File Manager does not support Explorer shell extensions, so you cannot use the WinZip shell
extension to drag a Zip to a folder to unzip it. However, you can still do this after installing Norton
Navigator by running the Windows 95 Explorer or by double clicking on My Computer.



Keyboard Usage

WinZip is easier to use with a mouse, but you can also use the standard Windows keyboard interface.
Keyboard accelerators defined for WinZip include:

Ctrl+N Create a new archive.

Ctrl+O Open an existing archive.

Ctrl+L Close an archive.

Ctrl+F Display Information about the open archive.

F7 Move an archive

F8 Copy an archive

Ctrl+R Rename an archive.

Ctrl+M Mail an archive.

Ctrl+A Add files to an archive.

Ctrl+D Delete files from an archive.

Ctrl+E Extract files from an archive.

Ctrl+V View files in an archive.

Ctrl+Slash (/) Select all items in the list box.

Ctrl+Backslash (\) Cancel the selection of all items in the list box.
Ctrl+S Run virus scanner.

Ctrl+T Test an archive.

Ctrl+K Create a self-extracting archive.

Ctrl+C Activate the CheckOut feature.

Ctrl+l Install files in an archive.

Direction key(s) Move the cursor or scroll to other items in a list box.
Shift+direction keys Select multiple items in a list box.

Enter Same as Double Clicking in the main window listbox.
Shift+F8 Toggle "add mode" on and off. When add mode is on, the selection cursor

blinks. In this mode you can use the Spacebar to select non-consecutive
items in the list box or to cancel the selections. Press Shift+F8 again to end
add mode. Clicking the left mouse button cancels any selections.

Hints and Tips

Here are some hints and tips you may find useful:

Learn to use the Windows help system! All Windows programs use the same help system, so
you will quickly make up for the time you spend learning it by being more productive in all your
Windows applications. To get started select How to Use Help from the Help menu.

Read the section Brief Tutorial if you have not yet done so.

Windows 95 and NT 4.0 users: see the section titled Windows 95 Quick Examples for many
useful hints.

Windows 95 and NT 4.0 users: use Quick View, the optional Windows 95 file viewing utility, to
view files without associations. If Quick View is not installed on your system, you can install it as
follows: open the Windows 95 CD-ROM, click Add/Remove Programs, double click Accessories,
check the "Quick View" box, then click OK. To use Quick View with WinZip, select Program
Locations from WinZip's Options menu, type "quikview" in the Default Association field (don't
type the quotes), then click OK.

Windows 3.1 users: use the File Manager instead of the Open dialog box to select archives you
want to open. Unlike the standard Windows Open dialog box, the File Manager lets you sort



archives by date and size. To open an archive from the File Manager either double click on the
archive or use the Drag and Drop Interface to drop an archive from the File Manager onto WinZip.

e Use the Drag and Drop Interface to add files to archives. The main advantage to using the Drag
and Drop interface over using the Add Dialog Box is that you can sort files by date and size in the
File Manager, making it easier to find the files you want to add.

e If you usually use the same folders when opening, extracting, or adding files, specify those
folders in the Folders dialog box. Choose Save Settings Now from the Options pull-down menu
to save your changes.

¢ To change the default WinZip window size and position to the current window size and position,
choose Save Settings Now from the Options pull-down menu.

e To switch to another program during an archive operation, click on the window for the other
program, or bring up the Task Manager by double clicking over the desktop or pressing CtrlI+Esc.
Note: you cannot use the WinZip system menu or minimize button while WinZip is executing a
DOS command.

¢ To interrupt an archive operation click on the WinZip window. This will activate the Operation
Interrupted dialog box.

e  Click on the Status bar to display the Archive Information dialog box.

¢  Click on the header in the main window to sort the list of files. For example, click on the word
"name" in the header to sort the list by name.

¢ Do you need to send files to end users who may not have an unzip utility? If so, try WinZip Self-
Extractor Personal Edition.

Related Topics:
More Hints and Tips

Hints For Working With Downloaded Files
Windows 95 and NT 4.0 Quick Examples

Frequently Asked Questions (FAQs



More Hints and Tips

WinZip determines what drive and folder to use for temporary disk files by checking the value of
the WZTMP=, TMP=, TEMP=, and PKTMP= environment variables, respectively. If none of these
environment variables is set, WinZip uses the root folder of your C: drive. You can override this
default by specifying a value as the Temp Folder in the Eolders dialog box. Choose Save
Settings Now from the Options pull-down menu to save any changes.

There are two ways to bypass the dialog boxes displayed when you drag files, drop files, and
press the Extract or View button: (1) hold down the shift key while performing the operation, or
(2) if you usually want to bypass the dialog box, turn off the appropriate option as described in the
section titled Configuration Dialog Box.

You can open archives with WinZip by double clicking in the Central Point Desktop 2.0 File
Manager if you turn off the Show Compression Files entry in the CPS File Manager's Tree
menu.

Under Windows 3.1 you can change the default WinZip icon as follows:
1. Click on the WinZip icon.

2. Press Alt+Enter, or press Alt while double clicking on the icon. The Program Item Properties
dialog box appears.

3. Click on Change Icon.
4. Double click on your preferred icon.
5. Choose OK.

You can use the right mouse button to select files in the main WinZip listbox without canceling
previous selections. This is often easier than using the standard shift-click method. For more
information on selecting multiple discontiguous files in the main WinZip list box, see the section

titled Using Extended Selection List Boxes.

If you have a large RAM disk, use it as a temp folder to significantly speed up many archive
operations.

You can move or copy files from one archive to another by opening multiple WinZip windows, one
for each archive, and dragging files from one to the other. Note that you need to turn off the
Reuse WinZip Windows entry in the Options pull-down menu in order to start multiple WinZip
windows.

Under Windows 3.1 and Windows NT you can start WinZip every time you start Windows by
adding the WinZip icon to the "Startup" program group. Be sure to select the Run Minimized
checkbox in the Properties dialog box.

WinZip can now be used to compress files with cc:Mail. To use this feature change the
compress= line in the [cc:Mail] section of the appropriate WMAIL.INI files to specify the full path
for WinZip followed by "-a %1 @%2". For example, if WinZip is installed in your c:\winzip folder,
specify

compress=c:\winzip\winzip.exe -a %1 @%2

Related Topics:

Hints and Tips
Hints For Working With Downloaded Files

Windows 95 and NT 4.0 Quick Examples

Frequently Asked Questions (FAQs



Version History

WinZip 6.3 features an updated zip/unzip engine with automatic built-in disk spanning for multi-disk Zip
files. Italso includes an interface to the new Internet Browser Support Add-On, which allows users to
download and open archives from the Internet with one click via Microsoft's Internet Explorer and
Netscape Navigator. WinZip 6.2 added support for MIME, UUencoded, XXencoded, and BinHex files,
Favorite Zip Folders, built-in encryption, and includes WinZip Self-Extractor Personal Edition. The main
new feature in WinZip 6.1 was the WinZip Wizard, an easy to use way to unzip and to install software
distributed in Zip files using the standardized and familiar "wizard" interface. WinZip 6.0a introduced
improved Windows 95 drag and drop support. WinZip 6.0 added many Windows 95 features, including
tight integration with the Windows 95 shell and Explorer-style dialog boxes.

Related Topics:
Changes in WinZip 6.3
Changes in WinZip 6.2
Changes in WinZip 6.1
Changes in WinZip 6.0a
Changes in WinZip 6.0



Changes in WinZip 6.3

Built-in Disk Spanning

WinZip 6.3 features an updated zip/unzip engine with automatic built-in disk spanning support for multi-
disk Zip files. If you create a Zip file on diskettes and the first diskette fills, then disk spanning is
automatically activated, and you are simply prompted to put in a new diskette to continue the archive.
There is no need to specify that you want to span before you start.

Interface to WinZip Internet Browser Support Add-On

WinZip 6.3 interfaces to the free Internet Browser Support Add-On, which allows users to download and
open archives from the Internet with one click via Microsoft's Internet Explorer and Netscape Navigator.
There is no need to "Save to disk" and then switch to WinZip or to the Windows Explorer or File Manager
to open the downloaded file. In addition, all files that have been downloaded are automatically copied
from the Internet Browser's temporary folders to a folder of the user's choice; this ensures that a
permanent copy of the download is saved on the user's system, even if the downloaded file is
automatically deleted by the browser.

Windows 95 & NT Explorer context (right-click) menus enhancements
¢ New "Add to <filename.zip>" entry to easily compress files in place.
¢ New "Extract to folder <filename>" makes it easy to unzip in place.
¢ New "Create Self-Extractor" entry makes self-extracting Zip files.
¢ WinZip context menus have an optional icon for easier identification.
e WinZip context menus can be placed in a sub-menu.

Other features in the new zip/unzip engine
e Empty folders are restored when unzipping.

e Empty folders are stored when zipping (however, they are not listed in the main WinZip window
for cosmetic reasons).

e Empty folders are removed after a successful "Move" zip operation.
e Attributes are automatically restored while unzipping.
e Attribute support for Zip files in the Add and Drop dialog boxes:
¢ Include files only if archive attribute is set.
¢ Reset archive attribute after adding files.
¢ Include system and hidden files.
e Option to "Skip Older Files" while extracting.
Other changes

e WinZip includes a work-around for a bug in DCOM95 and some pre-release versions of Microsoft
Internet Explorer 4.0 that results in a "Path too long" message when using the Extract dialog box
under Windows 95.

¢ WinZip no longer includes an option to run the MS-DOS PKZIP 2.04g (WinZip has not needed
PKZIP/PKUNZIP to perform basic zipping and unzipping operations for the past several releases,
but some users have assumed from the presence of this option that WinZip is only a shell for
PKZIP/PKUNZIP, and required these programs for basic operations).

e The Add and Drop dialog boxes include a Password button as an alternative to the Options-
>Password dialog box.

e Improvements to "View Last Output” dialog box:
¢ RichEdit control used under Windows 95 and NT for higher capacity.



e View Last Output results improved while testing Zip files:

e OK appears after each line.

e Summary line appears at the end of the listing.

The WinZip Wizard now handles password protected files.

WinZip handles certain invalid zips more gracefully.

WinZip Self-Extractor Personal Edition supports password protected Zip files.

Under Windows 95 and NT, WinZip Self-Extractor Personal Edition is now a 32-bit EXE file (while
earlier versions made it possible to build 32-bit self-extracting Zip files, the program that created
these 32-bit files was actually a 16-bit program).

32-bit self-extracting Zip files support Microsoft(R) Authenticode(tm) technology. In earlier
versions, the self-extracting Zip file's integrity check conflicted with Authenticode. (For
information on Authenticode, visit the Microsoft home page, click the "Search" button and search
for "authenticode code signing".)



Changes in WinZip 6.2

WinZip now lets you open and extract UUencoded, XXencoded, BinHex, and MIME files (base64,
plain/text, and quoted-printable). These files can be opened via the File/Open dialog or via drag and
drop. The Actions->UUencode menu entry makes it easy to encode archives.

The new Favorites toolbar button and the File->Favorite Zip Folders menu entry list all Zip files in your
favorite folders by date for easy access.

WinZip now includes built-in support for the industry standard Zip 2.0 encryption format.

WinZip Self-Extractor Personal Edition is now included with WinZip.

There are miscellaneous minor changes, for example, the Options->Password dialog box now has a
"mask" option; if you open an executable file that is a recognized format, WinZip now offers to run the file,
and if you double click on a SETUP program in an archive, WinZip acts as though you clicked the "Install"
toolbar button. A new large toolbar is available if your video configuration supports more than 256 colors.




Changes in WinZip 6.1

The main new feature in WinZip 6.1 is the WinZip Wizard, an easy to use way to unzip and to install
software distributed in Zip files using the standardized and familiar "wizard" interface. The WinZip
Wizard interface is not targeted at experienced users, but is ideal for the rapidly growing number of PC
users getting started on the Internet. When these users gain confidence or want to use more advanced
zipping features, the full WinZip Classic interface is just a click away.

WinZip Wizard features include:

e Fast access to Zip files you downloaded: no need to use the Explorer or File Manager to hunt
for the files you downloaded. The Wizard lists the Zip files in your "Favorite Folders" by date,
with the most recent files first, so you can quickly access the files you just downloaded. A search
feature will find any Zip files "lost" on your hard drive.

¢ Automatic installation of software distributed in Zip files: if a Zip file contains a "setup" or "install"
program, the Wizard will unzip the files, run the installation program, and clean up temporary files.

e Easy unzipping: just click "Unzip Now" and the Wizard will unzip your file and display the results
in the Explorer, so you can start working with the new files right away.

e Same easy-to-use interface on both Windows 95, Windows NT, and Windows 3.1.
WinZip Wizard vs Classic Interfaces:

Both the WinZip Classic and Wizard interfaces are included in all versions of WinZip. One click switches
from the Wizard to the Classic interface and vice versa.

e The WinZip Wizard interface is ideal if you want to know as little about Zip files as possible and
just "get started" with the files you downloaded. The wizard lets you click the "Next" button a few
times, and presto, your files are unzipped and/or installed. When you want to use more
advanced zipping features, you can easily switch to Classic mode.

¢ The award-winning WinZip Classic interface, featuring tight integration with the Windows 95 shell
and versatile drag and drop facilities, is great if you are comfortable using Windows and the
Explorer, or want to use advanced zipping features.

Windows 95 specific changes in WinZip 6.1 include:

e New Step by Step Tutorial.

¢ Under Windows 95 a new File->Create Shortcut menu entry creates a desktop shortcuts for the
open archive.

¢ Under Windows 95 the Extract dialog box displays folders in an explorer-style tree.

¢ Under Windows 95 you can specify quikview.exe in the Program Locations dialog box Default
Associations field without specifying the full path (assuming QuickView is installed).

e The Explorer context menu for self-extracting Zip files includes an "Open with WinZip" entry.
e The Explorer context menu for folders includes an "Add to Zip" entry.



Changes in WinZip 6.0a

WinZip 6.0a features improved Windows 95 drag and drop support. You can now extract files from the
main WinZip window using drag and drop to the Explorer or to the Windows 95 Desktop. You can also
drag files to an application shortcut to open the file using the application, or drag files to a printer to print.

Here is a summary of Windows 95 Drag and Drop facilities.
Features marked with an asterisk are new in WinZip 6.0a.

Drag from Drop on Result

*WinZip Explorer selected files are extracted

*WinZip App Shortcut selected files are opened with shortcut
*WinZip Desktop extract to desktop for easy access
*WinZip Printer file is printed

WinZip Open App file is opened in the application
Explorer WinZip drop files to add them to an archive
Explorer WinZip drop an archive to open it

Explorer Explorer drop files on a Zip to add them
Explorer Explorer right button drag a Zip to a folder

to extract

Aside from the Windows 95 drag and drop improvements, WinZip 6.0a is a maintenance release, with
support for programs that became available after WinZip 6.0 shipped (Norton AntiVirus and Scan 95) and
a few bug fixes.



Changes in WinZip 6.0

The most significant changes in WinZip 6.0 is the new Windows 95 support, detailed in the section titled
Windows 95 Features.

Other changes include:

WinZip now allows you to view multiple files in an archive without first closing the first file (earlier
versions of WinZip restricted you to closing the first file before viewing the second file). Under
Windows 95 the system "Quick View" program is normally used as the "Default Association" used
to view to files not associated with another program. Here are some implementation details:
when you double click on a file in an archive, WinZip extracts the file to the "Temp Folder"
specified in the Options/Folders dialog box. WinZip then runs the program associated with the
file so you can view the file. When you later close the archive WinZip deletes the temporary
file(s). If the file(s) have been modified WinZip will give you an opportunity to update the archive
with the modified file. The "Always on Top" flag is temporarily turned off if it is on when you view
a file, and is turned back on the next time you activate WinZip.

The File Manager Extension is now implemented under Windows 95, and Windows NT. You will
have to choose File Manager Configuration from the Options menu and check the second button
to activate this feature. The File Manager Extension works the same as it does under Windows
3.1

The WinZip installation procedure now includes "Express Setup” and "Custom Setup" options.
Custom Setup results in the "old" WinZip 5.6 behavior. Express Setup, the default, skips the
Program Locations dialog box, the File Manager Configuration dialog box, and "Create Program
Group" prompt.

With more and more people using the Internet, virus scanning is more important. As a result,
WinZip's support for virus scanners has been improved. The virus scanner parameters field now
supports two new special values: %d represents the folder containing the files to be scanned
(without a trailing *.*), and %f represents a temporary "report" file. %wscan is a special
parameter that should be used only for McAfee's WSCAN 2.14 and compatible scanners.

WinZip now searches for and supplies default parameters for four additional scanners: wscan, f-
prot, tbscan, and wfindvir. The "Run as Iconized DOS Session If Possible" checkbox has been
replaced with the "Run Minimized" checkbox, which is now used for both DOS and Windows
scanners.

The number one new support problem in WinZip 5.6 was caused by the "TAR File LF to CR/LF
Conversion". This option, intended for text files only, caused problems for binary files. The
option has been replaced by the "TAR File Smart CR/LF Conversion" option. When this option is
in effect WinZip determines whether to perform CR/LF conversion for each file by looking at the
first 80 characters in the file. If the file is a text file then single LF and CR characters are
converted to CR/LF pairs so the file can be viewed by Notepad and other Windows viewers.

Files are considered text files when first 80 bytes contain only characters with ASCII values
between 0x20 and Ox7f, carriage returns, line feeds, form feeds, tabs, and other alphanumeric
characters (as determined by the Windows IsCharAlphaNumeric API).



Fixing Zip Files

If an ZIP file is damaged it can sometimes be repaired with the PKZIPFIX command. PKZIPFIX is not
part of WinZip, it is part of the MS-DOS text mode Zip utility PKZIP® 2.04g from PKWARE®), Inc. This
utility is available on many ftp and download sites as PK204G.EXE. If you download and install this file,
you can run PKZIPFIX by simply typing

PKZIPFIX filename
at the DOS prompt, and PKZIPFIX will create the "fixed" file PKFIXED.ZIP.



Archive format

Select an archive format for the archive you are creating. You can avoid this prompt by selecting from
the Default Archive Format field in the Configuration dialog box.



Message WZ10

To create self-extracting archives, first create a standard ZIP, ARJ, or LZH file, then use the Make .EXE
File menu entries in the Actions pull-down menu. (While LHA lets you create archives with an extension
of .EXE, these .EXE files are not self-extracting archives, and attempting to run them can lock up your

system.)



Message WZ11

A required file was not found.
The file listed in the dialog box was not found in your path or the specified location. Also, WINZIP.HLP,
WZ.DLL, WZ.COM, and WZ.PIF must both be in the same folder as WINZIP.EXE. The Installation

section describes the complete installation procedure.



Message WZ13

This dialog box is displayed if WinZip was unable to open the specified archive, read the archive folder, or
if a flename is invalid. It is possible that the file is not an archive or does not exist. Alternately, it is

possible that the archive has been corrupted. Other reasons for this error include insufficient memory
and disk errors while reading the archive.

If you are working with a Zip file, you can try repairing the file as described in the section Eixing Zip Files.



Register WinZip

Please enter your name and registration number exactly as they appeared on the instructions you
received when you registered WinZip. You cannot substitute a different spelling for your name or
use a different name. |If entered correctly, your name will appear in the About dialog box, and the
registration reminder dialog box will no longer be displayed when you start WinZip. Please save this
information for possible use with future upgrades, or in case you re-install WinZip.

Note: If your name is spelled incorrectly in the instructions, please write to the address in the About
dialog box with the correct spelling, and you will receive a new registration number.



Internal Error

This dialog box is displayed when an unexpected WinZip internal error occurs. Please contact the author
with as much information about the error as possible. For a list of contact points, choose About from

WinZip's Help pull-down menu.



Message WZ14

This dialog box is displayed when a required edit field is empty or no entries are selected in a list box.
For example, it is displayed if you don't specify which file you want to open in the Open Archive dialog
box. Specify the required information and try again.



File already exists

To view a file, WinZip normally extracts the file to disk, reads it, and erases the temporary disk file.
WinZip determines which disk to extract to by checking the value of the WZTMP=, TMP=, TEMP=, and
PKTMP= environment variables. To conserve space on the DOS command line, WinZip creates
temporary files in the root folder of the specified drive. If none of these environment variables is set,
WinZip extracts to the root folder of your C: drive.

The message The disk file "filename" already exists. Should WinZip overwrite it so that the file in the Zip
can be viewed? is issued if a file with the requested name already exists on disk. If you choose Yes, the
existing disk file will be overwritten, and processing will continue. If you select No, WinZip will abort the
view operation for this file.



Warning WZ16

This dialog box is displayed if WinZip cannot display the entire file you are viewing because it contains
binary zeros. WinZip uses a standard multi-line edit field to display files, and these controls truncate text
at the first binary zero.



Message WZ17

This dialog box is displayed if you try to open a Zip with a folder too large for WinZip to handle.  You will
not be able to open the Zip file with this version of WinZip.



Message WZ8

This dialog box is displayed if an external command (for example, LHA or ARJ) is over 127 characters
long (the longest command allowed under MS-DOS is 127 characters). The total command line length
includes several components used internally by WinZip in addition to the external command. There are a
couple ways to reduce the length of the command line:

1) Move WINZIP.EXE (and the related files) to a folder near the root folder (for example, a folder like C:\
WINZIP is better than C:\WINDOWS\UTILITY\SHAREWAR\WINZIP).

2) Move the archive you are working with to a folder near the root folder.

3) Move ARJ.EXE, LHA.EXE, SCAN.EXE, etc. to a folder specified by your PATH= environment variable
and remove any folder names for these programs in the Configuration dialog box.

3) If you are adding, deleting, extracting, or viewing multiple files at one time, specify them via a list box
rather than an edit field. This causes WinZip to create an ARJ or LHA response file, which usually takes
less room on the command line than multiple file names.



Selected Text Successfully Copied To Clipboard

This dialog box is displayed to let you know the text selected in the View dialog box has been copied to
the system clipboard. You can paste the text into another application (for example, Notepad) by
choosing Paste from the application's Edit pull-down menu.



Message WZ18

This dialog box is displayed when WinZip could not create a required temporary file on the disk drive
listed in the dialog box. Possible causes are that the disk drive is invalid, or that the root folder of the
disk is full.

WinZip determines which disk to use for temporary files by checking the values of the WZTMP=, TMP=,
TEMP=, and PKTMP= environment variables. To conserve space on the DOS command line, WinZip
creates temporary files in the root folder of the specified drive. If none of these environment variables is
set, WinZip creates temporary files on your C: drive.



Message WZ19

When working with format files the "action" operation requires the program external program. This
program is not installed or improperly installed.

This message is issued when the external program "program" required for the "action" operation is either
not installed, or is installed in a folder other than the one specified in the Program Locations dialog box.
If the specified program is installed, select Program Locations from the WinZip Options pull-down menu
and specify the correct path information. If you do not have a copy of the specified program, see the
section titled Requirements for information on obtaining the program.



Message WZ20

The program required to perform the function you selected is either not installed, or is installed in a folder
other than the one specified in the Program Locations dialog box. For a complete list of supported
external programs and information on obtaining these programs see the section titled System

Requirements. Also see the section titled Installing Optional External Programs.
For example, this problem can occur if you try to extract files from an ARC file, but have not specified an
ARC extraction program in the Program Locations dialog box.



Message WZ21

WinZip can't find one of the programs specified in the active dialog box. If you specified a folder (for
example, you entered C:\UTILITY\LHA.EXE), then WinZip can't find the program in that folder. If you did
not specify a folder (for example, you entered LHA.EXE) then WinZip can't find the program in any of the
folders specified by your PATH= environment variable.

Note: if you update the PATH statement in your AUTOEXEC.BAT, the changes will not take effect until you
reboot your machine.



Message WZ22

WinZip does not recognize the name of the specified program. For example, you will get this error if you
specify XYZ.EXE as the name for LHA.EXE. WinZip lets you specify the drive and folder containing the
program, but prevents the use of unsupported file names to prevent unexpected errors.



Message WZ23

An external program returned a non-zero error level. Consult the documentation for the external
program for the meaning of the error, and/or use the View Last Output entry in the Options pull-down
menu to check for error messages issued by the external program.

Note: one likely cause for this error is using an old version of external programs. See the section titled
System Requirements for version information.



Delete Entire Archive

This dialog box is displayed to give you a chance to confirm that you really want to delete the entire
archive. Select No to abort the operation or Yes to delete the archive.



CheckOut Delete

This dialog box is displayed before closing an archive to give you a chance to have WinZip delete the
CheckOut folder and the CheckOut program group. Select Yes to delete these items and close the
archive. Select No to leave the CheckOut group and folder intact and close the archive. Select Cancel

to cancel the close operation.



Message WZ24

Since most new archives are created in ZIP or LZH format, and there is no single widely available
program to manipulate ARC files, WinZip does not provide facilities to create or update ARC files.
WinZip does support viewing, running, and extracting files in ARCs.



Message WZ25

This dialog box is displayed when WinZip cannot run a program. This can happen when a program
specified as a Windows Association was deleted from your system or was moved to a different drive or
folder. The following are the error codes Microsoft has documented:

Value Meaning

Out of memory

File not found

File not found

Path not found

Too many files open

Attempt to dynamically link to a task

D a0~ W N -~ O

Library requires separate data segments for each task

8 Insufficient memory to start application

10 Incorrect Windows version

11 Invalid .EXE file (non-Windows .EXE or error in .EXE image)
12 0OS/2 application

13 DOS 4.0 application

14 Unknown .EXE type

15 Attempt in protected (Standard or 386 Enhanced) mode to load an .EXE created for an earlier
version of Windows

16 Attempt to load a second instance of an .EXE containing multiple, writeable data segments

19 Attempt was made to load a compressed executable file. The file must be decompressed before it
can be loaded.

20 Dynamic-link library (DLL) file was invalid. One of the DLLs required to run this application was
corrupt.

21 Application requires Microsoft Windows 32-bit extensions.



Message WZ26

WinZip encountered an error trying to view a file. Possible errors include insufficient memory and I/O
errors.



Message WZ27

An incomplete filename was entered. If either a drive or folder is specified, then both must be specified.
For example, the following two filenames are incomplete:

C:LHA.EXE
\UTILITY\ALHA.EXE

In the first example, a drive is specified but no folder is specified. This can cause unexpected errors if
you change the current folder on the C: drive.

In the second example, a folder is specified but no drive is specified. This can cause unexpected errors
if you change the current drive.

Specify a filename like C:\UTILITY\LHA.EXE instead. Note that if the file is in a folder specified by your
PATH= environment variable you do NOT need to enter a drive and folder.



Warning WZ28

You used the Drag and Drop Interface to drop multiple files onto a WinZip window or icon, and at least
one of these files had an extension of ZIP, LZH, ARJ, or ARC. Press Yes to add these files to the open
archive.



Warning WZ29

The original release of Norton Desktop for Windows 2.0 does not accept files dropped by WinZip 4.0.
This means you can't drop files onto the NDW desktop, Desktop Item Icons on the NDW desktop, or
NDW group windows. Future versions of NDW, including a possible update to NDW 2.0, will probably
accept files dropped by WinZip. This dialog box is displayed as a warning that the drop operation may
fail because WinZip doesn't know whether files it drops will be accepted by your version of NDW.

The first time you see this dialog box just press the OK button. The drop operation will continue, and the
Extract dialog box will be activated. After the selected files are extracted, WinZip will attempt to drop the
files on NDW. If NDW does not accept the files, look for an update to WinZip or NDW in the not too
distant future. If NDW accepts the files, select the checkbox labeled "This version of NDW accepts files
dropped by WinZip" the next time this dialog box is displayed to suppress display of the dialog box in the
future.



Message WZ30

WinZip could not change to the specified folder, so it is closing the open archive. Possible causes for
this error include removing the folder, or changing disks in the middle of a WinZip operation.



Message WZ31

An unexpected system error was encountered trying to run the specified DOS command. This problem
is usually caused by a system configuration problem such as using a Windows 3.0 video driver on a
Windows 3.1 system, or using buggy video drivers, including "beta test" video drivers.

If you encounter this error message and are not using a Microsoft supplied video driver, try installing the
VGA driver distributed with Windows to determine if the problem is caused by a video driver.



Message WZ32

WinZip cannot detect errors issued from NAV unless you have DOS version 4.0 or later. Either use a
different virus scanner or leave the virus scanner edit field blank.



Overwrite?

The specified file already exists on disk. Choose Yes to overwrite the file or Yes to All to overwrite this
file and avoid this prompt for all other files during this operation. Choose No to bypass this file and
continue the operation or Cancel to abort the extract operation.



File has been changed

WinZip detected that you modified a file after viewing it. Choose Yes to add the modified file to the
archive or No if you don't want to update the archive.



Warning WZ35

The original file included folder information, but no folder information was included when the file was
added to the archive. Thus, both the original and the new file are included in the archive.



Delete Temporary File?

Choose Yes to delete the temporary file or No if you want to keep it. Note that the file resides in a
"temporary" folder specified by your WZTMP=, TMP=, TEMP=, and PKTMP= environment variables, so
you should probably move the file to a "permanent” folder if you really want to keep it.



Warning WZ37

WinZip detected that the Control Panel "Exclusive in Foreground" option is selected. This option
prevents WinZip from running DOS programs like LHA.EXE in the background. For proper WinZip
operation, you must turn off this option. Under Windows 3.1 you can do this as follows: first double click
on the Control Panel icon, then double click on the "386 Enhanced" icon; next, click on the "Exclusive in
Foreground" checkbox, and finally push the OK button.



Message WZ38

WinZip cannot accept dropped files while the Drop dialog box is active. Close the Drop dialog box before
dropping more files on WinZip.



Message WZ39

WinZip requires ARJ 2.3 or later. The date of your ARJ.EXE is earlier than 1/19/91, the date on which
ARJ 2.3 was released. Please obtain a newer version of ARJ. See the section titled System
Requirements for information on obtaining the most recent version of ARJ.



Message WZ40

The Zip file cannot be opened. If this Zip file is part of a backup set, please insert the last disk of the
backup set and try again. WinZip needs the last disk of the backup set to read the end-of-central-folder
record. You may subsequently be prompted to insert other disks from the backup set.

If you downloaded this file, the most likely cause of this problem is a bad download. The best solution is
almost always to download the file again. If this does not solve the problem, see the web page
http://www.winzip.com/downprob.htm for hints on resolving download problems.

If you did not download this file, and it is not part of a backup set, it is either not a valid Zip file or it is
corrupt, perhaps because of a bad floppy disk.



Message WZ41

Obsolete



Message WZ42

Obsolete



Message WZ43

Obsolete



Message WZ44

An invalid CheckOut folder was specified. You cannot specify a root folder (e.g. C:\), and you must
specify a drive letter (e.g. CA\CHECKOUT, not just CHECKOUT). The CheckOut folder cannot be the
folder containing the open archive, since all files in the CheckOut folder are deleted at the beginning of

the CheckOut operation.



Create Associations

Create File Manager Associations for ZIP, LZH, ARJ, and ARC files?

Answer Yes to this prompt if you want WinZip to create File Manager Associations so that you can start
WinZip by double clicking on these files. If you answer No the installation will continue but you will need
to open archives using the Open Archive dialog box or the Drag and Drop interface.



Warning WZ46

obsolete



Message WZ47

WinZip could not create the specified folder. Possible causes are:
e Afile exists with the same names as the folder
e Disk is read-only

e Folders preceding the final folder do not exist. For example, to create the folder "C:AUTILITY\
FILES" the folder "C\UTILITY" must exist.

Solution: specify a different folder name.



Message WZ48

Due to a limitation in the Windows 3.1 Program Manager, it is impossible to remove a Program Manager
group while closing Windows. Thus, if you want to remove Program Manager groups created by WinZip,

you need to close WinZip before closing Windows.



Message WZ49

obsolete



Message WZ50

An error occurred opening, writing to, closing, or deleting the specified file. Possible causes include a
misspelled filename, a full disk, a read-only or locked disk, or a read-only or locked file. The operation in
progress will be aborted. Another dialog box with more specific information may be displayed.

This message may also be displayed because of an invalid archive. For example, if an archive is
damaged (possibly due to line noise while downloading from a BBS) it may contain invalid pointers or
corrupted header information.



Message WZ51

The open archive no longer exists on disk. It was probably deleted by another task.



Message WZ52

Nothing To Do: No files were found for the specified action. Examples of when this messages is issued
include attempts to add a non-existent folder to an archive and attempts to freshen an archive that is
already up to date.



Message WZ53

An invalid archive operation was initiated. For example, an attempt to add the same file from two
different folders can cause this error. Check the warning messages for additional details about the

problem.



Message WZ54

This error occurred during internal Zip processing. Correct the error and retry the operation.



Message WZ55

WinZip could not access the correct version of the specified DLL. It is possible that the DLL from a
previous version of WinZip is still loaded, or that the wrong version of the DLL is in the WinZip folder. To
solve this problem follow both of these steps:

1) Verify that the DLL in your WinZip folder has the same date as WINZIP.EXE or WINZIP32.EXE.
If not, reload all WinZip related files from the distribution disk. DO NOT use WinZip to extract
files from BBS distribution version of WinZip to the folder from which you are running WinZip,
since that can cause unpredictable results.

2) Exit Windows and then run WinZip again. Closing Windows ensures that old versions of the DLL
are not loaded.



Message WZ57

There is insufficient free memory (RAM) on your system. Close one or more other applications and retry
the operation.



Warning WZ58

One or more warning messages were issued. Press the Yes button to view all messages issued while
processing the last action, including informational and warning messages.



Virus Scan Complete.

This message is issued when a Windows-based virus scanning operation completes. If no error or
warning dialog boxes were displayed by the virus scanner, then this dialog box indicates that no viruses
were found. The Norton Anti-Virus scanner, the Central Point Anti Virus program, and any other properly
configured virus scanner will display error or warning dialog boxes if a virus is found.



Message WZ60

To use the NAVW virus scanner you need the version distributed with Norton Desktop 2.2 or later. This
message is issued if your NAVW.EXE has a date/time stamp prior to January 3, 1993. Either use a
different virus scanner or leave this field blank until a new version of NAVW is installed.



Message WZ61

The open archive does not contain any files that match the filespec you entered in the Extract dialog box.



Message WZ62

WinZip could not copy, delete, rename, or move the file. Possible causes include: the file is read-only,
the file is open by another process, or the file has already been deleted by another process.



Message WZ64

WinZip uses the standard Windows "Common Dialog Boxes" as a basis for the Add dialog box. Due to a
limit in the Common Dialog Boxes the total length of all selected files cannot exceed 2000 characters.
You have exceeded or may exceed this limit. You can circumvent this limit by using the Drag and Drop

interface to add files instead of the Add dialog box, or by specifying wildcards in the Add Files field in the
Add dialog box (for example, *.c).



Message WZ65

WinZip could not make the specified folder the current folder. Probable cause: invalid or non-existing
folder name.



Message WZ66

The temporary folder must be a fully qualified path. You must specify both the drive and folder, for
example, C:\\TEMP or C:\WINDOWS\TEMP. If you don't know the location of your temporary folder, click

Cancel.



Operation Interrupted

The archive operation was interrupted because you pressed a key or clicked on the WinZip window
during the archive operation. Press the Continue button to continue the operation or the Abort button to
terminate the operation.

This message will be displayed if you try to minimize WinZip during an archive operation. To switch to
other tasks you can click on another window or use the task list (press Ctrl+Esc).



File Is In Use

Afile can be "in use" for one of two reasons:

1)

2)

The file is open by another process. For example, a document might be open by a word
processing application.

The file is "in use" by Windows. Files that are "in use" are typically programs (.EXE files) or
dynamic link libraries (.DLL files) being run by the system. For example, you will get this
message if you attempt to overwrite C:\WINZIP\WINZIP.EXE while running C:\WINZIP\
WINZIP.EXE. The solution is to extract to a different folder, for example, C:\WINZIP5 instead of
C:AWINZIP.

WinZip will not let you overwrite or delete a file that is "in use" by the system because this
operation could cause unpredictable results, including system crashes. Windows may read from
files that are "in use" at any time, and does not expect these files to change. If the file has been
overwritten Windows will not know the data has changed and can become confused.

If this message is issued during an Extract operation you can either extract the file to a different folder, or
retry the operation after closing the program that is using the file.

If this message is issued while WinZip is trying to delete a folder or file you can either continue without
deleting the folder or file (and delete it manually later on) or close the file in question and re-try the
operation.



Message WZ67

Cannot create filename. File already exists. Open existing file?

This message is issued when you press the New button on the toolbar or select New from the File menu
to create an archive but the specified archive already exists. Since the file already exists it cannot be
created. Press the Yes button to open the existing file or the No button to abort the operation.

Normally you should press the Open button to open an existing archive.



Message WZ68

Cannot open filename. File does not exist. Create new file?
This message is issued in one of two situations:

1. You pressed the Open button on the toolbar or selected Open from the File menu and specified
the name of a file that does not exist.

2. You selected a filename from the File menu history list, but that file no longer exists.

Since the file does not exist it cannot be opened. Press the Yes button to create a file with the specified
name or the No button to abort the operation.

Normally you should press the New button to create an archive.



Message WZ69

Due to Windows limitations it is not possible to run two different versions of the same program with the
same name at the same time. As a result, you cannot use WinZip's Install/Try/Uninstall feature to install

WinZip.



Message WZ70

This dialog box is displayed when Windows returns a "File Not Found" error when WinZip tries to run
another program. Possible causes include:

1. A program specified as a Windows Association was deleted from your system or was moved to a
different drive or folder.

2. Arequired DLL or other component is not installed (e.g. VBRUN300.DLL).



Message WZ71

WinZip could not create a folder because a file (not another folder) with the same name exists. For
example, if a file named "foo" exists you cannot create a folder called "foo" in the same folder. Choose a
different name for the folder you are trying to create, or delete the file with the conflicting name.



Message WZ72

For seamless integration with WinZip your virus scanner must support automatic scanning. At the time
this version of WinZip was released MWAV does not to support automatic scanning.  Click Yes to
continue if you are sure your version of MWAV supports automatic scanning, otherwise press No and

select a different scanner.



Message WZ73

WinZip was unable to make the folder displayed in the Add dialog box the current folder. In some
operating environments this can be caused by using UNC names. Another possible cause for this
problem is a conflict with a "common dialog box" enhancement utility.



Caution

The Caution dialog box lists items that cannot safely be uninstalled but were changed during the install
process. These items are unlikely to interfere with a successful uninstall. For example, a setup
program might replace your existing copy of a common dynamic link library like CTL3D.DLL with the
latest version of the same library. In normal situations your existing applications should work with the
latest version of the library, so leaving this new version installed will not cause problems.



WZ74
(Win32 only)

This archive contains files with long filenames or blanks. However, you are using an external archive
utility (e.g. LHA or ARJ), and external archive utilities don't support long filenames. Thus some (or all)
operations involving this archive will fail. For example, if the archive contains the file "A LONG NAME"
and you try to extract it using ARJ, the file will be called "A LONG N".



WZ75

The archive does not contain complete filename information, so WinZip cannot determine the full filename

of the compressed file. Replace all or some of the suggested filename with the corrected name and
press OK.



WZ76

This compressed file contains an archive. Normally you will want to have WinZip automatically
decompress and open the archive. If you choose Yes WinZip will

e Decompress the archive into your temporary folder (as specified in the Options/Folders dialog
box).

e Open the archive in the temporary folder.
e Later, when you close the archive in the temporary folder, WinZip will automatically delete it.
Note that the original compressed file is not changed by this operation.



WZ77

This compressed file is stored in the "KWAJ" format introduced after Windows 3.1. Your copy of the
LZEXPAND.DLL or LZ32.DLL cannot handle this compressed file. The version of LZEXPAND.DLL
distributed with Windows for Workgroups 3.11 works fine, while the old one distributed with Windows 3.1
will not work. Unfortunately, the LZ32.DLL distributed with initial release of Windows NT 3.5 will not
handle these files, and Microsoft has not released documentation on this file format. You can usually
decompress these files with the EXPAND command (from the DOS command prompt enter "expand /?"
for instructions).



WZ78

The file you tried to open does not appear to be in the Microsoft Compress (LZEXPAND) format. Note
that not all files ending with an underscore are in the Microsoft Compress format. For example, some
files in the "BBS distribution" version of WinZip have names ending with an underscore but are not in the
Microsoft compress format.



WZ79

WinZip could not create or replace the specified Zip file. WinZip successfully created or updated the Zip
file in the temporary working folder, but was unable to copy the result to the destination disk. The most
likely cause for this error is a full disk or a write protected disk. The updated file is left on your hard disk
with the specified filename. After correcting the problem (e.g. freeing up some disk space or removing
the write-protect tab from the disk) you can copy the specified filename to the destination disk manually.



WZ380

Please use the 32-bit version of WinZip under Windows 95 and Windows NT. The 32-bit version is
included on the WinZip distribution disk. The evaluation version of the 32-bit version is available from the
WinZip home page (http://www.winzip.com) and on CompuServe in the GO WINZIP file area.



WZ381

Obsolete.



WZ382

Obsolete



WZ83

The SETUP or INSTALL program in this archive contains folder information, for example, win32\setup.exe
and/or win16\setup.exe. Use Actions/CheckOut instead of Actions/Install for this archive.



WZ84

WinZip encountered a problem processing a UUencoded, XXencoded, MIME, or BinHex file. Details on
the problem are in the message text. Possible causes for this message include:

e The file is corrupt. In this case, you will need to obtain another copy of the file.

e The file contains incomplete header information. Be sure not to remove any header information,
including subject fields, and MIME headers. For example, never delete anything that looks remotely
like this

Content-Type: multipart/mixed; boundary="----
= NextPart 000 01BB5CFA.BB6BBC8O"

Content-Transfer-Encoding: 7bit

—————— = NextPart 000 01BB5CFA.BB6BBC80--

Hint for Microsoft Mail (MS-Mail) users: if you receive an encoded file by e-mail, save it to disk before
opening the message. Just select the message while it is in the inbox, then choose "File/Save As" and
select a filename such as "message.uue”. If instead you double click on the message, it may be
truncated, because MS-Mail limits message text to about 16kb.



WZ85

The Favorite Zip Folders dialog box current shows the results of searching one or more disks. You have
changed the search criteria (for example, from searching for all Zip files to all encoded files), so WinZip
needs to re-scan the disk(s) for files matching the new search criteria. This could take a few moments.
Click Yes to start the search now.



WZ386

The PRE-RELEASE BETA TEST version of WinZip you are using should be replaced with the current
version of WinZip. You can always download the current version from the GO WINZIP area on
CompusServe, or from the WinZip home page at

http://www.winzip.com

This message will be displayed every time you run WinZip, unless you modify the INI file as described in
the message. IMPORTANT: use a text editor like Notepad to modify the INI file, not a word processor
like Microsoft Word or Write. Also, be sure to close all WinZip windows before modifying the INI file,
otherwise your changes to the INI file may be lost when you close WinZip.



Association Problem

Some of WinZip's most useful features require that WinZip is associated with Zip files and other archives.
For more information on associations see the section titled Windows Associations.

It is strongly recommended that you answer Yes to this prompt.
Press the Info button for diagnostic information.



Association Problem Details

This dialog box lists the following information:
Full filename of current WinZip: Note the exact drive and folder information.

Current Zip Association: this field should include the EXACT name of the "current WinZip" shown
above. If this filename is different it is possible that you have two copies of WinZip installed in different
folders. In this case you will probably want to remove the older copy.

Current Registry value of the Zip key: This value should be "WinZip".



Association Information

If the Associate WinZip With Archives option is unchecked you will not be able to double click on Zip
files and other archives to open them. Other features, including the Explorer shell extensions, rely on

having WinZip associated with archives. For more information on associations see the section titled
Windows Associations.



WinZip Self-Extractor Personal Edition

Overview

WinZip Self-Extractor Personal Edition is included with WinZip, under the terms of the WinZip License
Agreement. It makes it easy to create files that unzip themselves. The following information applies to
both WinZip Self-Extractor Personal Edition and WinZip Self-Extractor 2.1, a separately available extra
charge add-on.

What is a Self-Extracting Zip File?

A self-extracting Zip file is an executable program file (.EXE file) that includes a Zip file and software to
extract or "unzip" the contents of the Zip file. Users can run (execute) a self-extracting Zip file just as
they run any other program.

When a self-extracting Zip file created by WinZip Self-Extractor is run, a dialog box is displayed. This
dialog box makes it easy for the user to change the "unzip to" folder before starting the extract or "unzip"
operation.

Self-extracting Zip files created by WinZip Self-Extractor are 100% compatible with the Zip 2.0 file format,
so they can be unzipped by standard unzip utilities like WinZip and PKUNZIP.

What are the advantages to Self-Extracting Zip Files?

Users can extract or "unzip" files from a self-extracting Zip file without running a separate unzip utility or
knowing how to use an unzip utility. Thus, self-extracting Zip files are particularly suited distribution of
software to beginning users who are not familiar with the concept of Zip files.

Self-extracting Zip files created by WinZip Self-Extractor are native Windows programs so they are easy
to use even for users with no MS-DOS experience.

How Does it Work?
There are two parts to the process:
1) The WinZip Self-Extractor program creates self-extracting Zip files.

2) When WinZip Self-Extractor creates a self-extracting Zip file it includes part of itself in the self-
extracting Zip file. The part of WinZip Self-Extractor included in the self-extracting Zip file is what
makes it possible to unzip the files by simply running the self-extracting Zip file.

The person who creates the self-extracting Zip file runs WinZip Self-Extractor once, specifying the name
of the Zip file. The resulting self-extracting Zip file can be distributed to many people, and will unzip itself
when it is run.

Related Topics:

WinZip Self-Extractor Personal Edition - Operation
WinZip Self-Extractor 2.1



WinZip Self-Extractor Personal Edition - Operation

The easiest way to start WinZip Self-Extractor Personal Edition is to first create a normal Zip file with
WinZip, then select Make .EXE from the WinZip Actions pull-down menu. Unless you have specified a
different program in the Make EXE field in the WinZip Options->Program Locations dialog box, the WinZip
Self-Extractor Personal Edition dialog box will be displayed. If you chose to create a WinZip Self-
Extractor Personal Edition icon while installing WinZip, you can also start the program by double clicking
on this icon.

WinZip Self-Extractor Personal Edition dialog box contains the following fields:
e The name of the standard (not self-extracting) Zip file to turn into a self-extracting Zip file.

e The default target folder for the unzip operation. If left blank the folder specified by the user's
TEMP= environment variable is used.

¢ You can create one of two types of self-extracting Zip files:

1. 16-bit Windows: This option creates self-extracting Zip files that run under Windows 3.1,
Windows 95, and Windows NT. However, if the Zip file contains files with long filenames and
if the self-extracting Zip is run on Windows NT, a message box is displayed warning the user
of potential problems, and any long filenames will be truncated.

2. 32-bit Windows 95 and NT: This option creates self-extracting Zip files that include full long
filename support under Windows 95 and Windows NT. Because these self-extracting files
are full 32-bit programs they will not run under Windows 3.1 or Windows for Workgroups.

¢ Whether the CTL3D.DLL should be used to generate 3D effects for the self-extracting Zip file.
CTL3D.DLL is used by many applications to generate 3D effects so there is a good chance it will
exist on a lot of target systems. If this option is specified WinZip will try to load CTL3DV2.DLL,
and if not found, will try to load CTL3D.DLL. Note that there is no way for WinZip Self-Extractor
to guarantee that the CTL3D*.DLL on the target system will function properly.

e Whether the Overwrite Files Without Prompting option in the self-extracting Zip file's dialog box
should be checked by default.

Press the Make EXE button to create the self-extracting Zip file. Be sure to test the Zip file before
distributing it.

Related Topics:

WinZip Self-Extractor Personal Edition - Overview
WinZip Self-Extractor 2.1



WinZip Self-Extractor 2.1

WinZip Self-Extractor Personal Edition is included with WinZip, under the terms of the WinZip License
Agreement. WinZip Self-Extractor 2.1, a $49 add-on to WinZip, includes the following features not
available in the Personal Edition:

Features to automate and customize software installation, such as the ability to specify an icon
and text for the main self-extractor dialog box, and to delete temporary files after running a setup
program. It includes support for the InstallShield 3.0 SETUP program.

Ability to run a command when the unzip operation completes.

Self-Extracting files can be created from the command line.

An option to create a single self-extracting Zip file that runs under either MS-DOS or Windows.
All versions can be created with English or German messages.

Ability to automatically extract files when the EXE file is run.

A Wizard to simplify the process of building self-extracting files.

Click here for information on obtaining WinZip Self-Extractor 2.1.

Related Topics:

WinZip Self-Extractor Personal Edition - Overview
WinZip Self-Extractor Personal Edition - Operation



Obtaining WinZip Self-Extractor 2.1

WinZip Self-Extractor 2.1 costs $49 for a license to create an unlimited number of re-distributable self-
extracting Zip files on a single machine. Click here for information on the differences between WinZip
Self-Extractor 2.1 and the Personal Edition included with WinZip.

You can order WinZip Self-Extractor 2.1 by credit card via the WinZip home page
(http://www.winzip.com) or by phone, fax, or e-mail as described below. You can also order using
CompuServe's SWREG service by registering product ID 4866, or by sending a check for $49 to Nico
Mak Computing, Inc. at P.O. Box 540, Mansfield, CT 06268, USA. All payments must be in US funds
drawn on a US bank. Shipping by postal mail is included in the $49 price. Be sure to include your
name, your organization name, and, if you are ordering by credit card, your credit card number, expiration
date, and the name as it appears on the card.

Credit card orders for WinZip Self-Extractor 2.1 can be placed through PsL, a credit card ordering service.
You can reach PsL 24 hours a day 7 days a week by fax at 1-713-524-6398 or by CompuServe mail to
71355,470 or Internet mail to 71355.470@compuserve.com. You can also call PsL at 1-800-242-
4PsL(4775) or 1-713-524-6394 between the hours of 7:00 am and 6:00 pm CST Monday-Thursday and
7:00 am and 12:30 pm CST on Fridays, except holidays. Important: these numbers are for credit card
orders only. All other inquiries should be directed to Nico Mak Computing, Inc.

You can download a fully functional evaluation version of WinZip Self-Extractor 2.1 from the WinZip
Home Page (http://www.winzip.com) or the "WinZip Support" library in the GO WINZIP area on
CompuServe.



Search for Favorite Zip Folders

Click Search Entire Hard Drive to search all hard drives on your computer for folders containing .ZIP
files and folders name "download" or "dnload". Click Quick Search to search only for a few folders likely
to contain Zip files (e.g. cserve\download and aol\download).

Floppy drives, network drives, and CD-ROMs are not searched. To search for files on these devices,
click the Search button in the Select Zip File panel (in the WinZip Wizard) or the Favorite Zip Folders
dialog box (in WinZip Classic), then click | know where it is.

Details on the File Type filters in the Search for Files of Type combo box are documented in the section
File Type Filters.



Brief Tutorial - Contents

Click on each tutorial topic, in sequence, to learn all about WinZip:

_I 1. Introducing WinZip _I 2. The WinZip Window _I 3. Opening Archives
4. Viewing Files _I 5. Extracting Files _I 6. Creating New
Archives
7. Adding Files I 8. peleting _Files [19. custom

Configurations
1 10. Additional Features

This brief overview tutorial introduces you to each of the main WinZip concepts and features to
get you working productively as quickly as possible.

You will get the most benefit from these lessons if you change the size of this Help window to leave
enough room on the screen to have WinZip opened at the same time. As the screens describe an
operation, you may want to try certain things with WinZip to gain an even better understanding. You can
move through it as quickly or as slowly as you like. If you ever have any questions when you are using
WinZip, remember that context-sensitive help is available by pressing the F1 key.

If you prefer a strict "learning by doing" approach, there are "step by step" options available, too, if you
want to try them as well.

Ll windows

35 users may like the WinZip Tutor interactive help system that takes newer users step by step through

two basic features: unzipping and zipping up a sample zip archive that is included for your convenience.
Windows

31 users can read through the Step by Step Example and follow the steps it prescribes. It gives very

specific instructions for you to follow, complete with filenames.

As you explore this tutorial, you will find highlighted text that will take you to additional information about a

particular topic. If you elect to take the detour, you can click on the Back button at the top of this page to

return to where you left off in the Brief Tutorial.

Important: WinZip offers many convenient ways to work with archives. This tutorial approaches the
topic using the main WinZip window as its base of operations. This is not the only way to access
WinZip's convenient features. For example, you can use WinZip to zip and unzip files without leaving
the Explorer. Once you are comfortable with the basic operations described in this tutorial, be sure to

read the sections Windows 95 Quick Examples and Hints and Tips.
Next



Brief Tutorial - Introducing WinZip

Click on each tutorial topic, in sequence, to learn all about WinZip:

1. Introducing WinZip L 2. The WinZip Window I 3. Opening Archives

1 4. viewing Files I 5. Extracting Files I 6. creating New
Archives
7. Adding Files I 8. peleting _Files lo. custom

Configurations
1 10. Additional Features

WinZip is a tool to make working with Zip and other types of archive files easier. Let's start off by
discussing some of the words used to describe the files and the processes.

Archives are files that contain other files, and Zip files are the most common archive format. Typically,
the files in an archive are compressed. WinZip uses the term "Add" to mean "compress files and add
them to an archive". "Extract" means "decompress files in an archive, creating separate files on a disk".
Some people use the verbs "zip" and "pack” instead of Add, and "unzip" or "unpack” instead of "extract".

See About ZIPS and Other Archives for more detailed information.
Next



Brief Tutorial - The WinZip Window

Click on each tutorial topic, in sequence, to learn all about WinZip:

I 1, introducing WinzZip 2. The WinZip Window Il 3. Opening Archives
4. Viewing Files I 5. Extracting Files I 6. creating New
Archives
7. Adding Files I 8. peleting _Files lo. custom

Configurations
1 10. Additional Features

The WinZip window is where you start many of your operations. You can open it by clicking on the WinZip
icon in Windows 3.1 Program Manager or through the Windows 95 Start menu. The WinZip window also
opens automatically if you double-click on an archive in File Manager or Explorer.

The WinZip window includes standard Windows components. Of particular interest:

The Title Bar displays not just the WinZip product title, but the name of the archive you are currently
working with. The Toolbar provides quick ways of performing the most common tasks. The Main
Window Area displays information about the files in the archive, and you'll find as we get further into this
Tutorial that many operations can be done directly with these files. Finally, the Status Bar displays the
number and sizes of currently selected files, along with other archive information.
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Brief Tutorial - Opening Archives

Click on each tutorial topic, in sequence, to learn all about WinZip:

1. introducing Winzip 2. The WinZip Window 3. Opening Archives
4. Viewing Files I 5. Extracting Files I 6. creating New
Archives
7. Adding Files I 8. peleting _Files lo. custom

Configurations
1 10. Additional Features

Working with Existing Archives - Opening Archives

The first step is to open an archive. Select Open Archive from the WinZip File pull-down menu to
activate the standard Open Archive dialog box or use the Open toolbar button.

Then, select the archive you want to open in the Open Archive dialog box. This dialog box works just
like the Open dialog boxes in other applications: just select the file you want to open from the list of files.
(If you want to create an archive instead of working with an existing archive, see the section Brief Tutorial
- Creating New Archives).

Once an existing archive is open you can extract or work with the files in the archive. The files in an
archive are listed in a list box in the main WinZip window.

* You can look at all the file names, with details, stored in the archive, using the scroll bar,
arrow keys or usual Windows commands.

*  You can quickly sort the main window by clicking once on the header (e.g. click on "Name" in
the header above the list of files to sort the list by filename).

Z
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Brief Tutorial - Viewing Files

Click on each tutorial topic, in sequence, to learn all about WinZip:

I 1, introducingWinzip I 2. The WinZip Window L 3. Opening Archives
4. Viewing Files I 5. Extracting Files [ 6. creating New
Archives
7. Adding Files I 8. peleting _Files lo. custom

Configurations
1 10. Additional Features

You can easily view any of the files stored in an archive by double clicking on the file in the main WinZip
window. WinZip will open the file with the associated application. For example, a Word (DOC) file may

be displayed in Word, and a text (TXT) file in Notepad. When you double click on a program file (.exe), it
is run.

Or, you can view a file with the built-in viewer or a viewer of your choice by selecting View from the
Actions pull-down menu.

Next



Brief Tutorial - Extracting Files

Click on each tutorial topic, in sequence, to learn all about WinZip:

I 1, introducingWinzip I 2. The WinZip Window L 3. Opening Archives
4. Viewing Files B 5. Extracting Files [ 6. creating New
Archives
7. Adding Files I 8. peleting _Files lo. custom

Configurations
1 10. Additional Features

When you extract a file, WinZip decompresses it and places it in the folder of your choice. You can
restore whole folders and retain the structure of any sub-folders.

If you select Extract from the Actions pull-down menu or the Extract toolbar button, a dialog box is
presented to let you choose the folder where you'd like WinZip to place the extracted files. For more

details on that dialog box and its options, press F1 later, when you encounter it, or click on Extracting
Files from an Archive now.

Next



Brief Tutorial - Creating New Archives

Click on each tutorial topic, in sequence, to learn all about WinZip:

I 1, introducingWinzip I 2. The WinZip Window L 3. Opening Archives
4. Viewing Files I 5. Extracting Files Ml 6. Creating New
Archives
7. Adding Files I 8. peleting _Files 9. custom

Configurations
1 10. Additional Features

You can create a new archive by selecting New Archive from the WinZip File pull-down menu or from the
New toolbar button. This activates the New Archive dialog box.

First, you type the name of the archive you want to create, not the names of the files you want to
compress. This dialog box works similarly to standard Windows' file dialog boxes, so you can choose the
drive and folder where the archive will be created. The names of any existing archives on the selected
drive and folder are listed to help you choose a name that is not already in use.

Normally after creating an archive you will want to add files to the archive, so verify that the Add Dialog
check box is checked to automatically activate the Add dialog box.

Next



Brief Tutorial - Adding Files to an Archive

Click on each tutorial topic, in sequence, to learn all about WinZip:

I 1, introducingWinzip I 2. The WinZip Window L 3. Opening Archives
4. Viewing Files I 5. Extracting Files I 6. creating New
Archives
Bl 7. Adding Files I 8. peleting _Files [19. custom

Configurations
1 10. Additional Features

You can add files to an existing archive you've opened or to a new archive you've created, as in the
previous section. If the Add dialog box is not displayed select Add from the Actions pull-down menu or
from the Add toolbar button.

In the Add dialog box you can select the files to add to the archive in one of two ways:

e Type the name(s) of the file(s) you want to add to the archive. Multiple names can be separated
by spaces, for example, *.TXT *.DOC will add all TXT and DOC files.

¢ Click on any file(s) in the dialog box. You can select multiple files as described in the section
Using Extended Selection List Boxes.

Once you are done making your file selection, click to add the files. Once WinZip finishes, it will update
the file list in the main window to reflect the new files in the archive.

You can also add files to an archive by dragging the files you want to add from File Manager or Explorer
and dropping them on the WinZip window. This is described in detail in the section titled Adding a File to
an Archive with the Drag and Drop Interface.

Note: When you add files to an archive, the original files on disk are not deleted. If you want to delete
the original files automatically after a successful Add operation, select Move from the Action field.

Next



Brief Tutorial - Deleting Archives and Files

Click on each tutorial topic, in sequence, to learn all about WinZip:

I 1, introducingWinzip I 2. The WinZip Window L 3. Opening Archives
4. Viewing Files I 5. Extracting Files I 6. creating New
Archives
7. Adding Files Bl 5. peleting Files [19. custom

Configurations
1 10. Additional Features

WinZip can remove selected files from within an existing archive, or delete the entire archive.  Delete
from the Actions menu to activate the Delete dialog box. There are two ways to start the action to delete
files from an archive:

You can select entries from the list box in an archive already opened by WinZip, and then select
the Delete entry from the Actions pull-down menu or press the delete key.

Select the Delete entry from the Actions pull-down menu to bring up the Delete dialog box. You
can then specify the file names you want to delete (standard MS-DOS wildcards are accepted).
You can specify multiple file names, separated by spaces.

Note: these operations cannot be undone.

To delete an entire archive select the Delete entry from the Actions pull-down menu to bring up the Delete
dialog box. Then select the Entire Archive radio button and click on the Delete push button.
Alternatively, you can select Delete Archive from the File menu.
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Brief Tutorial - Custom Configurations

Click on each tutorial topic, in sequence, to learn all about WinZip:

I 1, introducingWinzip I 2. The WinZip Window L 3. Opening Archives
4. Viewing Files I 5. Extracting Files I 6. creating New
Archives
7. Adding Files I 8. peleting _Files Bl 9. custom

Configurations
1 10. Additional Features

Many WinZip operations can be tailored using configuration options. For example, you can change the
default folders for the Extract and Add dialog boxes. Most options are intended for advanced users.
For an overview of available options see the section titled Options.

Next



Brief Tutorial - Additional Features

Click on each tutorial topic, in sequence, to learn all about WinZip:

I 1, introducingWinzip I 2. The WinZip Window L 3. Opening Archives
4. Viewing Files I 5. Extracting Files I 6. creating New
Archives
7. Adding Files I 8. peleting _Files lo. custom

Configurations
Bl 10. Additional Features

This is the end of the Brief Tutorial. As you get to know WinZip better, be sure to explore the following
more advanced features:

e Drag and Drop operations simplify archiving.
¢ Internet, America Online, CompuServe, and other online services users: see the section titled
Downloading and Processing Files with WinZip

e The Install/Try/Uninstall and Checkout features make it easy to try software distributed in
archives.

e WinZip is integrated with the Windows 95 shell and the Windows 3.1 File Manager. See the
sections titled Explorer Interface and File Manager Interface for details.

Reminder: press the F1 key at any time while working with WinZip for context-sensitive help.
You may want to review the tutorial and explore some of the many links it contains by pressing the

buttons above. You can return to the Help Contents page by clicking on the Contents button in the
toolbar.



WinZip stores compressed files in archives. You can think of an archive as being like a folder or
directory, though an archive is really a special kind of file. WinZip recognizes a file as an archive when it
has a .zip or other special extension.



When you compress a file you make it much smaller. Other words for compress are zip and pack.



When you add a file to an archive, WinZip automatically compresses it.



The Switch Interface dialog box is displayed if you start WinZip with the Wizard interface mode and close
WinZip while using the Classic interface, or vice versa. This dialog box gives you a chance to control
whether WinZip will start in Wizard or Classic mode next time you run WinZip.



When you first open the Favorite Zip Files dialog box, all Zip files in your Favorite Zip Folders are listed by
date.

Click Search to search for Zip files in other folders. The results of your search will temporarily replace
the list of files in the Favorite Zip Folders dialog box.

Click Options to add or remove folders from your list of Favorite Zip Folders.



WinZip can help you find Zip files if you don't know exactly where they are. Select Search hard disks
on this PC to search your all hard drives on your PC (network disks and CD-ROM disks are not
searched). Select Search Favorite Folders to search for Zip files in your Favorite Zip Folders. Select

Search Disk to search a specified disk (for example, a floppy disk or CD-ROM). Select Let Me Find It if
you want to look for the file yourself.



File Type Filters

The File/New Archive, File/Open Archive dialog boxes use the file type filters in the following table. The
File/Favorite Zip Folders dialog box uses the first three entries in this table.

*

Zip files .Zip

all archives *.Zip;*.z;*.gz;* tz;* taz;*.tgz;* .1zh;*.arj;*.arc;* tar

encoded files *.uu; *.uue; *.xxe;*.bhx;*.b64;*.hgx

archives and .exe files *.Zip;*.z;*.gz;* tz;* .taz;*.1gz;* .I1zh;*.arj;*.arc;* .tar;*.exe

archives, encoded, and .exe files *.Zip;*.z;*.gz;* tz;* taz;*.t1gz;* .I1zh;*.arj;*.arc;* .tar;*.exe; *.uu;
*.uue; *.xxe; *.bhx;*.b64;*.hgx

all files (*.*) *x

UUencoded, XXencoded, BinHex, and MIME files

WinZip can open and extract UUencoded, XXencoded, BinHex, and MIME files (base64, plain/text,
and quoted-printable), and can UUencode files. This section explains the need for these features and
abilities, includes instructions for using them, and shows how they can bring a whole new dimension to
your e-mail operations.

Use the browse buttons above or the index below to page through this tutorial, and learn
about using these important and useful WinZip features.

These instructions assume that you understand basic Windows and WinZip operations, and the basic
use of your e-mail program.

UUencoded, XXencoded, BinHex, and MIME files

Sending Files using Internet Mail
The Why behind UUencoding and Other Schemes
Receiving and Preparing Files for Decoding
Decoding Files using WinZip
UUencoding a File using WinZip
Mailing a UUencoded File
Hints, Tips, & Troubleshooting



Sending Files using Internet Mail

If you have a direct connection to the Internet, you may already be using an e-mail program that allows
you to attach files to messages. However, many e-mail programs, including MSMail and CompuServe
Information Manager (WinCIM), cannot easily transfer files to Internet addresses. In the case of
CompuServe, users cannot easily send files beyond the bounds of their own service, to Internet
subscribers and others. WinZip can enable you to send and receive files using nearly any e-mail
program, including these two.

Note: If your e-mail program does have the ability to transfer files, consider using WinZip to compress
them before transfer -- it will usually take far less time since the file will be smaller. If the recipient is
unfamiliar with Zip archives, you can use WinZip to create a self-extracting archive for their
convenience.

UUencoded, XXencoded, BinHex, and MIME files
Sending Files using Internet Mail

The Why behind UUencoding and Other Schemes
Receiving and Preparing Files for Decoding
Decoding Files using WinZip
UUencoding a File using WinZip
Mailing a UUencoded File
Hints, Tips, & Troubleshooting




The Why behind UUencoding and Other Schemes

The Internet was not designed to carry binary (program and other non-text files) files. It is able only to
transfer messages made up of conventional text (printable ASCII) characters. In order to get around
that limitation, UUencode and other methods were created.

These solutions all perform the same basic operation: they encode the non-transferable binary file into
ASCII characters that the e-mail system can handle. The person receiving the message can then
decode the strings of characters to recreate the original file. Perhaps you have seen such one of these
completely unintelligible messages; here's an example:

:=: Part 001 of 001 of file encoded.txt

begin 666 encoded.txt

M5&5S8="$-"Q@T*1V5N=6&QE (%) EB61E<CH-"Q@T*5&AI<R!I<R!N;WlH:6YG (&UO
M<F4@=&AA;B!A ('1lE<WOQROFEL92!C<F5A=&5D ('10 (' 'R;W9I9&4@9F]D9&5R
M(&90<B!T:&4@=F%R:6]U<R!E; F-O9&EN9R!S8VAE; 655+B!) 9B!Y;W4@87)E
M('5S:6YG(&ET ('10 ('1E<WOL (&-0;F=R871U; &%T:6]N<R!O;B!Y;WS5R (&%G
M:6QI="D@:6XA8W5T=&ENIRPE<&SS=ENIRPA<VSV:6YG+" !A; FOQ@9&5C;V1I
1 F<@=7-1;F<@5VENGFEP+QT*#0I%;FI0>2S$"

end

WinZip can easily open and extract UUencoded, XXencoded, BinHex, and MIME files (base64,
plain/text, and quoted-printable) that have been sent to you, and create Uuencoded files for you to
send.
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Receiving and Preparing Files for Decoding

The message you receive with an encoded file will need to be prepared for the simple WinZip
decoding operation. The steps you take will depend on the e-mail program you are using.

If you are using CompuServe Information Manager (WinCIM),
Double-click on the message to open it,
Select Save As from the File menu item,
Enter a file name using .UUE as the extension; for example: FILENAME.UUE.

If you are using MSMail,
Highlight the message (DO NOT open it; large messages are not handled well by MSMail)
Select Save As from the File menu item,
Enter a file name using .UUE as the extension; for example: FILENAME.UUE.

If you are using another e-mail program, one of the two methods described above may also work
with your program. Be aware that some e-mail programs may crash or cut off parts of unusually large
messages, so saving them as a file without opening them is the preferred method.

Your e-mail program may save a message attachment as an external file in a folder designated to
receive them. In that case, it may automatically be named; you may wish to rename it, using a .UUE
extension, for maximum convenience.

Sometimes you may receive multiple messages, where a file is split up into more than one message
because of size limitations. You will need to use a text editor or the DOS COPY file command to paste
the files together into one large file, and save it as a text file with a .UUE extension.
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Decoding Files using WinZip

You do not need to worry if the file being sent is UUencoded, XXencoded, BinHex, or a MIME file
(base64, plain/text, and quoted-printable). WinZip will detect the method being used and automatically
decode it.

As is the case with zip archives, WinZip offers more than one way to open encoded files. For
example:

Double-click on the file with the .UUE extension

WinZip will execute and decode the file. If it is a zip archive, it will offer to open it. If it has not
been compressed, it will be shown in the usual manner.

Use WinZip in the regular manner to Extract the file to your folder of choice.

Note: You can also open a file using WinZip's Open toolbar button, or drag and drop a file into WinZip,
regardless of the file's extension.
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UUencoding a File using WinZip

WinZip UUencodes zip archives for mailing, so you must choose and open an existing Zip file to
encode or create a new one.

If the file is already archived as a Zip file, open it in WinZip using your favorite method.

If the file(s) you wish to send is not already archived, use WinZip to create a Zip file, and leave
the program open for the next step.

Click on the Actions menu item, and choose UUencode.

A UUencoded file has been created from your zip archive. For example, you will find a TESTFILE.UUE
file in the same folder along with your original TESTFILE.ZIP.
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Mailing a UUencoded File

How you include a UUencoded file in a message will depend on your e-mail program.
If you are using CompuServe Information Manager (WinCIM),
Create a message in the usual manner.

Note: If you are sending a file to another CompuServe address, it is unnecessary to UUencode
it, but zipping it using WinZip will shorten transmission times.

Click on the Attach button to open WinCIM's File Attachment window.
If you are using WinCIM 2.0, click on File (when using version 3.0, this step is not necessary).
Use the standard file dialogs to choose the .UUE file you created in the previous step.

If you are using CompuServe Information Manager 3.0, highlight the attached file in the Attach
Files dialog box, select "Text" in the File Type combo box, then click OK (when using version
2.0, this step is not necessary).

E-mail your message as you would normally.

If you are using MSMail,
Create a message in the usual manner.
Click on the menu item Attach, and select File.

Use the familiar file dialogs to choose the .UUE file you created in the previous step, then click
OK.

E-mail your message as you would normally.

If you are using another e-mail program, one of the two methods described above may also work
with your program. A "Send File" or similar option may be available and of use in this situation. It may
be necessary to open the .UUE file you have created using a text editor, copy the entire contents, or
portions of it, to the Windows clipboard, and paste it into your open e-mail message. Further
information on handling large files is included in the next topic, Hints, Tips, & Troubleshooting.
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Hints, Tips, & Troubleshooting

WinZip makes decoding these file attachments very convenient. Here are some hints to make the road
even smoother:

The most common problems we encounter with files than cannot be decoded are incomplete data
and missing header information. The integrity of the message is critical, and the header must be
intact for decoding. We have included short examples of each of the following encoding formats. You
may find them helpful for comparison purposes with messages you receive, to confirm that they
appear properly encoded and are not missing header and closing data. Click to review any of these
brief file examples.

UUencoded Example XXencoded Example BinHex Example MIME (base64)
Example

Multi-Part Encoded Files must be combined before they can be processed by WinZip. If you
encounter encoded data spread across multiple files, you can either combine the parts using a text
editor, and then open them with WinZip, or you can use another program, like the UUDeview package
from Frank Pilhofer. (WinZip's decoding subroutines are based on the UUDeview package.) The
original UUDeview is a text mode command line driven program, or you can download a Windows
interface by Michael Newcomb. These free programs are available from the Internet addresses
http://www.uni-frankfurt.de/~fp/uudeview (Germany) and http://www.miken.com/uud (USA), respectively.

Further information about encoding files can be found in many places on the Internet. A good place
to start is the "Introduction to Decoding" article on the UUDeview Home Page at http://www.uni-
frankfurt.de/~fp/uudeview. The MIME specification is defined in RFC 1521, and is widely available on
the Internet.

Bug Reporting: If you believe, after examining and confirming that a file seems properly encoded, that
WinZip should handle it, please contact WinZip support. Send e-mail to support@winzip.com with
details, and include a zip archive of the file so that it is not changed by any mail gateways or e-mail
program. Do not remove any header or other information. Please include the name of the program that
created it, if possible. Smaller files are preferred over huge sample files. We will examine the file and
respond as soon as possible.
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UUencoded Example

Here is an example of a UUencoded file:

begin 666 encoded.txt

M5&5S="$-"@T*1V5N=&QE (%) E861E<CH-"QT*5&AI<R!I<R!N;W1H:6YG (&UO
M<F4Q@=&AA;B!A ('1E<WOQOFEL92!C<F5A=&5D('10('!R;W9I9&4@9F]D9&5R
M(&90<B!T:&4@=F%R:6]U<R!E; F-O9&EN9R!S8VAE; 65S+B!) 9B!Y;W4@87)E
M('5S:6YG(&ET ('10 (' 1E<WOL (&-0; F=R871U; &%T:6]N<R!0;B!Y; W5R (&%G
M:6QI="D@: 6X@8W5T=4¢ENIRPE<&$S=4ENIRPR<VEV: 6YG+" !A; FO@9I&5C; V1T
:;F<@=7-1;F<Q@5VENGFEP+QT*#0I%;FIO>2S"

end

Return to Hints, Tips, & Troubleshooting



XXencoded Example

Here is an example of a XXencoded file:

begin 666 encoded.txt
hJ4JInRO2BOU08FqJiR41Z637ZMKFZQXcB0U08J4VdOm-dOm-iPrFcOKtb64p]
hQaTUR4VVPW-V65FZQrEUNaZgNG-XQaJVR4JY65F ] 65-mPrNdN4 IUNaxYN4Jm
h64NjQW-004IURa3mOKxpOm-ZPaBjN4ZiNm-nMgqVZPKInOW-7NW-tPrIUML7Z
h65JnOKtb64Z065F]65FZQrEg64BjPaRmMLFpP4300KxiQm-jPW-tPrdm643b
hOK1dR5YUOKsUMrJoR4ZiNmkUQ43nR4ZiNmkUQg3gOKtb90-VPaEUN4JXPgFd
OPaQURLBAPaQUJqZiKazk9Uo81Ed3PadjSG2+

+

end

Return to Hints, Tips, & Troubleshooting



BinHex Example
Here is an example of a BinHex file:

VGVzdCENCgOKR2VudGx1IFJ1YWR1cjoNCgOKVGhpcyBpcyBub3RoaW5nIGlvemUgdGhhbiBhIHRL
c309ZmlsZSBjcmVhdGVkIHRVIHBYb3ZpZ2GUgZmOkZGVyIGZvciB0aGUgdmEFyaW9lcyBlbmNvZGlu
ZyBzY2hlbWVzLiBJZiB5b3UgYXJ1IHVZzaWSnIG10IHRVIHR1c30sIGNvbmdyYXR1bGFOaWOucyBv
biB5b3VyIGFnaWxpdHkgaWdg¥Y3V0dGluZywgcGFzdGluZywgc2F2aW5nLCBhbmQgZGVjb2Rpbmcg
dXNpbmcgV21uWmlwLg0KDQpFbmpveSE=

Return to Hints, Tips, & Troubleshooting



MIME (base64) Example
Here is an example of a MIME file:

—_n

Content-Type: application/octet-stream; name="encoded.txt"
Content-Transfer-Encoding: base64

Content-Disposition: inline; filename="encoded.txt"
Content-MD5: V8ttTjZgvmMkzwVEKr50lw==

VGVzdCENCgOKR2VUdGx1IFJ1YWR1cjoNCgOKVGhpcyBpcyBub3RoaWsnIGlvemUgdGhhbiBh
IHR1c309ZmlsZSBjcmVhdGVkKkIHRVIHByb3ZpZGUgZmOkZGVyIGZvciB0aGUgdmFyaW9lcyBl
bmNvZGluZyBzY2hlbWVzLiBJZiB5b3UgYXJ1IHVZzaWSnIG10IHRVIHR1c3Q0sIGNvbmdyYXR1
bGF0aW9ucyBvbiB5b3VyIGFnaWxpdHkgaW4dgY3V0dGluZywgcGFzdGluZywgc2F2aW5nLCBh
bmQgZGVib2RpbmcgdXNpbmcgV21luWmlwLgOKDQpFbmpveSE=

Return to Hints, Tips, & Troubleshooting



Frequently Asked Questions

For the most up-to-date Frequently Asked Questions, click the FAQ link on the WinZip Home Page
(www.winzip.com).

Basic

How do | get started?

Technical

How do | use disk spanning?

How do | compress a folder and later restore it?

How do | view graphic/spreadsheet/word processing files in an archive?
Non-Technical

How do | purchase WinZip?

Do you keep track of address changes?

Related Topics:

Hints and Tips

More Hints and Tips

Hints For Working With Downloaded Files



How do | compress a folder and later restore it?

Note: There are easier ways to do this, but this is the easiest to explain. In particular, using the drag
and drop interface or the WinZip menu entry in the File Manager can save you most of these steps.
Windows 3.1 users: If you do use drag and drop or the WinZip menu entry in the File Manager to
compress a folder be sure to click on the folder in the RIGHT File Manager window, and drag that to

WinZip.

How to compress a folder and its subfolders:

1.
2.
3.

Start WinZip
Select New Archive from the File menu

Type the name of the archive, for example:
C:\MYDIR.ZIP
and press the Enter key

Select Add from the Actions menu

Type the full filespec of the files you want to add, for example:
C:\MYDIR\*.*

Be sure the Recurse Folders box is checked and the Save Extra Folders Info box is NOT
checked

Under Windows 95, press the Add With Wildcards button. (In Windows "wildcards" are the
asterisk and question mark characters. These let you specify multiple files at once, for example,
"* Txt" refers to all files with a file type of "Txt".) Under Windows 3.1, press the Add button.

How to restore a folder and its subfolders:

A w DN ==

Start WinZip and open the ZIP created in step 1 above
Select Extract from the Actions menu
Be sure the Use Folder Names checkbox is checked

Type the destination folder, for example
C:\MYDIR

Press the Extract button



How do | view graphic/spreadsheet/word processing files in
an archive?

Windows 95 or NT 4.0 Users:

Quick View, the optional Windows 95 and NT 4.0 file viewing utility, makes it easy to view many popular
graphics, spreadsheet, and word processing files. By default, if Quick View is installed on your system,
WinZip will use it to view files that are not associated with another application. If Quick View is not
installed on your system, you can install it as follows: open the Windows 95 or NT 4.0 CD-ROM, click
Add/Remove Programs, double click Accessories, check the "Quick View" box, then click OK. To use
Quick View with WinZip, select Program Locations from WinZip's Options menu, type "quikview" in the
Default Association field (don't type the quotes), then click OK.

Windows 3.1 Users:

Unfortunately, unlike Windows 95 and NT 4.0, Windows 3.1 does not include a file viewer. You can
purchase a file viewer from a third party and specify its location in the Program Locations dialog box.



Do you keep track of address changes?

We track address changes, so we can send you upgrade notifications. If you purchased a copy of
WinZip and have moved, please send us the following information:

1.

o o bk w

Your name (If you are not sure how you spelled your name when you registered, please include
common alternate spellings, e.g. "J. E. Smith", "Jim Smith", etc).

Your e-mail address , if any (please double check it! almost 10% of the people that sign up for our
mailing list type an invalid address; e-mail addresses are notoriously difficult to spell correctly).

Your new postal mailing address.

Your old postal mailing address.

Approximate purchase date.

Important: please indicate how you purchased WinZip:
By check

Via PsL (Credit Card order via Public Software Library)
CompuServe's SWREG service

Reseller (please include reseller name)

Thank you!



WinZip Internet Browser Support Add-On

The free WinZip Internet Browser Support Add-On will automate much of the work normally associated
with downloading compressed files from the Internet. When you click on a Zip file using Netscape
Navigator/Communicator or Microsoft Internet Explorer, WinZip will take over when the download is

completed. WinZip automatically moves the downloaded file to your download folder (initially set to c:\
download) and then opens the file.

Notes:

e WinZip's Internet Browser Support Add-On is not part of the WinZip distribution package; it is
available as a free download from the web page http://www.winzip.com/ibrowser.cgi.

¢ WinZip's Internet Browser feature supports Microsoft Internet Explorer and Netscape
Navigator/Communicator, and depends on the implementation these browsers use for "helper”
applications. WinZip 6.3 has been tested with the latest release and the latest publicly available
beta versions of Microsoft Internet Explorer, Netscape Navigator, Windows 3.1, Windows 95, and
Windows NT, as of mid July, 1997. It is possible that at some point in the future the browser
vendors will release new versions of their browsers with different interfaces and conventions that
are incompatible with WinZip 6.3's Internet Browser integration. If this happens, we plan to adjust
WinZip to make it compatible. We cannot guarantee that this will be practical, however, and it is
possible that WinZip's Browser Integration will not be available for future versions of these
browsers.






